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INTRODUCTION

The challenge is to write a silk screen printing handbook that can be of some use to all my students at
the Art League in Alexandria, from beginner to expert, as well as to those who come across my
website but can’t take my class. If distance is the issue, please look for a local class or workshop to get
you started. At the very least, watch a bunch of videos online. Expect them to contradict each other.
There’s no one right way to do things, but plenty of people believe there is.

I'm afraid there’s not even one right word or phrase to describe the process. Silk screen (one word or
two) is traditional, stemming from the original Japanese practice of holding pieces of a paper stencil in
place with strands of silk thread stretched tightly across a frame. | still like to call it silkscreen.

The first name change occurred in the 1930s, in America, when a group of artists working for the
WPA'’s Federal Arts Project began to investigate the possibilities of silkscreen as a fine art medium. In
western culture, silkscreening had been considered a commercial process, especially since the
invention of the squeegee in the 1920s, and the development of automatic silkscreen printing
machines to produce wallpaper, fabric, and other items. Commercial uses for the process have
continued to expand; it now adds up to a multi-billion dollar-a-year global business. Screenprinted
items include electronic circuitry, car-window heating systems, coffee cups and skateboards.

To distinguish the fine art medium from the commercial one, the WPA artists coined the word
“serigraphy,” meaning “drawing in silk.” | have two quarrels with the term “serigraph.” The first is its
attempt to sound high-brow. As Frances and Norman Lassiter put it in their “Screen Printing” text
(1978, still sold by Speedball):

“[One] must consider the application of the term serigraphy as an attempt to confer status
by affecting a European association. This appears both inaccurate and self-denying, since, in
screen printing, unlike painting, sculpture or the other printing processes, we find an art
medium which owes little to Europe, but much to America for its growth and development.”

The second reason | don't like the name “serigraphy” is that it seemed to get taken over by the
reproduction industry, where paintings or other works of art were reproduced as “serigraphs,”
typically in the largest possible editions that could still be considered “limited.”

| have no issue with the term “screen printing” (or “screenprinting”). It is up-to-date and accurate. The
real problem for the public these days is understanding the distinction, if any, between an original
hand-pulled print and a beautiful computer-printed “digital pigment print” or “Giclee.” The confusion
is totally understandable: “Print” so often means “reproduction,” which, after all, is the origin of all
printmaking media, way before machines. “Silk screen” at least avoids use of the word “print,” though,
of course, a silkscreen is a print. A drawback of the term “silkscreen” is that it can refer to any of three
things: the process, the finished art, or the fabric-stretched frame itself (which is rarely silk now, but
Dacron polyester).

To name the Art League class, we compromised with “Silk Screen Printing.”
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Whatever you want to call it, this fine-art medium had a heyday beginning in 1962, when Andy
Warhol made a splash with his series of giant, garishly-colored serigraphs of Marilyn Monroe. Another
pop artist, Roy Lichtenstein, specialized in turning cartoons (often of the True Romance variety) into
huge paintings and serigraphs, complete with over-size pretend half-tone dots. Robert Rauschenberg
had begun to pave the way for the pop art movement in the 1950s, reacting against the seriousness
and angst of abstract expressionism. A master of many media and a big influence on other artists, he
continued to produce serigraphs, among other works of art, until shortly before his death in 2008.
Rauschenberg’s many-layered, complicated prints and collages combined delicate photographic
silkscreen techniques with playful colors and abstract shapes.

Throughout the 60s, artists’ interest in silkscreen continued to grow. Art students involved in civil
rights and anti-war protest movements found silk screen printing to be ideal for making big, colorful
protest posters cheaply and quickly. Many rock 'n’ roll posters were silkscreened, too.

Nobody seemed to be thinking very much about the potential health hazards of the process. But it
turned out that the solvents in those quick-drying oil-based inks created a lot of bad fumes, especially
given the size of the posters and how quickly they could be cranked out. The solvents used for clean-
up were worse yet. A whole classroom of silkscreen students could create an awful lot of fumes. Not
knowing any better, | used to like those smells. Over the years, people gradually became aware there
was a problem, and we printers tried to deal with it by using fancier ventilation systems, carbon-filter
masks, gloves and other precautions. Meanwhile, reports of the health risks, including permanent
central nervous system damage, became increasingly alarming. After 15 years with oil-base inks, |
finally had a top-notch ventilation system, and wore a carbon-filter mask, but printing was still
making me sick to my stomach. I'd had enough; it was time to switch to water-based inks.

Many printers looked askance at the water-based system, believing it to be inferior, but | did not find
that to be the case. In 1987, when | switched over, Hunt-Speedball offered Permanent Acrylic inks and
a good transparent base, and their stencil materials readily allowed the use of both block-out and
photographic stencils. Yet, many of the techniques were different or backwards from what | was used
to, and | had a lot of trouble at first with paper rumpling from the moisture. Luckily, as | made the
transition, | got a great deal of help from Dennis O’'Neil at the Corcoran and Lois Johnson at
Philadelphia College of Art (now University of the Arts). | remain grateful to them, and to my RISD
silkscreen teacher Art Wood, for everything they taught me. Now that | get to teach silkscreen myself,
| enjoy passing on what | can. And in every class | teach, the ideas of the students add to my
understanding of just how many ways there are to use the silk screen process to make good art.
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TOUR OF THE CLASSROOM / GOOD STUDIO PRACTICES

Our classroom at the Art League is known as the “Multi-purpose Room.” Besides silkscreen printing, it
is used for photography, drawing and painting, Art Camp, weekend kids’ classes, and more. So our
clamped-on plywood tabletops must be removed and put away at the end of the class, along with all
the inks and supplies. There’s a lot to store, but when everybody chips in, it happens fast.

If your prints are dry at the end of class, you may either leave them in the folder on the screen-
drying shelves or take them home. If still drying, they can be left on the racks, raised to the ceiling.

Individual set-up

Your work area is one-half of a plywood-topped table, equipped with a pair of hinge clamps to hold
your screen in place. You should also have a 3-shelved movable cart, to hold printing paper, inks,
other supplies, and personal items.

Supply table

On the supply table are pens and pencils, brushes, freezer paper, contact paper, rulers, block-out
stencil supplies, scissors, X-acto knives, various kinds of tape, and a few other supplies.

Vertical shelves for screen storage

On the top left-hand shelf are the screens you will be using. The yellow ones are the finer mesh

(230), best for small-scale text, tiny details and delicate half-tones. The white ones are a slightly
coarser mesh (195), best for printing on fabric, and equally well suited for most applications on paper.
The coarser mesh lets through a heavier deposit of ink. Whichever type you choose, please put your
name, in marker, where it can be seen when the screen is shelved. The screen is yours to take home at
the end of the 9-week class. If you don’t think you'll use it, you can donate it to the class as a
communal screen. And then if you ever change your mind, you can come pick out a (free) communal
screen to replace it.

COMMUNAL SCREENS are on the bottom left-hand shelf. Each one is marked “Art League.”
When choosing one to borrow, hold it to the light to make sure there is no stencil or stencil residue
on it. (An ink stain is OK, so long as it’s not actually clogging the mesh.) Unless the supply runs low,
these screens may be borrowed for more than a week. On a piece of masking tape, temporarily mark
the screen with your name. Remember to clean the stencil off carefully when you're finished with it.

Racks

Hanging from the ceiling are two rows of clothes-pin racks, rigged up on a rope-and-pulley system,
secured by a boat-cleat screwed to the wall. When not in use, the racks can be raised toward our high
ceiling, safely out of the way of other classes. Never untie the whole rope from the cleat!

Squeegee cart

On the squeegee cart are squeegees of various lengths, sharpness, and flexibility. Also on the cart are
small blocks of wood, to hold up your raised screen between passes, while printing. On the bottom
shelf are the longest squeegees, plus newspaper for covering the clean-up table, and a big bag of
embossed papers and other items for texture rubbings (sometimes used in making stencils).
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Clean-up and photo table

The table near the sinks is covered in a couple layers of newspaper, with wooden supports positioned
to hold screens up off the table, in a horizontal position, while applying stencil remover.
Equipment for coating screens with photo emulsion includes the scoop coater, tin foil, a quart jar
of emulsion mixed with sensitizer, square-edged scrapers, paper towels, and a timer for exposure.
Clean-up supplies are nitrile and rubber gloves, emulsion remover, Screen Filler remover, a
paintbrush for spreading emulsion remover, and separate scrub brushes for each type of cleaner.

Sinks

The sink in the corner has a garden-hose nozzle, attached to an appliance hose, instead of a regular
spigot. This is where to spray the ink out of screens, facing the corner. If the sprayer is in use and ink is
getting dried onto your screen, you can set your screen in one of the other two sinks and at least
wipe it down with a wet rag while you wait. If you get a lot of ink on a rag, especially if it’s a strong
color, please rinse it out. (Our favorite rags are sections of old towels, or painter’s rags.)

The sink on the right has an over-zealous strainer that clogs a lot, so that we often have to reach
down and pick out any dried paint or other debris that’s blocking the holes. Sorry.

On the shelf above the sink is a spray bottle of Simple Green, which can help remove ink that is
staining or dried onto your screen. Don’t expect to remove every trace of ink stain, especially if you
have printed onto a new screen with a strong color, most notably black straight from the jar, and
especially if you don’t clean it out as soon as you've finished printing that color.

Power washer

Not in the room but down the hall in the janitor’s closet is our pressure-washer unit. We balance our
screens on a bucket in the floor sink, surrounded by a clear vinyl shower curtain hung on a hinged,
wall-mounted, square-shaped shower rod. Don’t use it for cleaning ink off a screen, but rather for
removing emulsion and block-out stencils. For removing emulsion, it’s a must. Set the screen with the
flat (under)side toward you so you don’t get sprayed in the face.

Darkroom

After screens are coated with photo emulsion, they must dry in the dark for at least 45 minutes.
Drying time is sped somewhat by a box fan on the floor and an exhaust fan in the ceiling. When you
enter the darkroom, leave both doors open briefly, so you can see.

Exposure room

Right off the classroom is a restroom, with a big counter directly under a bank of three 500-watt
halogen work lights. On the counter is a 3” foam rubber pad, covered with black paper to reduce
glare, and two pieces of 1/4”plate glass. The foam pad and glass are both cut around 18 x 26", a little
smaller than the inside dimensions (20 x 28”) of our standard screens. (The outside dimensions are 23
x 31”.) It doesn’t matter if the light in the room is on, unless you spend extended time arranging your
transparencies on the screen. Room lighting doesn’t affect the emulsion much, because it’s not
visible spectrum light that the Diazo photo emulsion reacts to, but UV spectrum light rays (in the 330
- 440 nanometer range, if you know your nanometers).

Because the glass should be fairly cool, since heat as well as light can harden the emulsion, we
have a spare piece of plate glass, and sometimes a box fan on the floor to cool it down.
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Ink-mixing table

| try to organize inks on the blotter-covered table in much the order | would arrange colors on a
painting palette, in a long line the length of the table. At one end, purple, then blues, then green;
white near the middle; then yellows, orange, the reds, brown and black. A quart jar of transparent ink
(transparent base mixed with extender base) is with the mixing bowls, near the middle of the table.
Gold and silver ink don’t correspond with anything on a painter’s pallette, so | just put them near the
yellows because they’re bright.

The quarts of store-bought inks run down the middle of the table, and the colors people have
mixed follow the same color order as best they can. On the “cool color” end of the table you'll find
mixed blues and purples on one side and greens on the other. On the “warm color” end, | put mixed
yellows, oranges, reds and pinks on one side, and neutral colors—whites, grays, browns, and
blacks—on the other. This way, to find a potentially useful mixed color, you don’t have to search the
whole table. As you choose and mix colors, you can get some idea how they will look on your print if
you wipe with a little fingerprint of ink onto a scrap print or the blotter, for a general idea of a color’s
intensity and opaqueness, since those can be hard to judge when the ink is sitting in a bowl.

Also on the mixing table are bowls, spoons and curve-edged spatulas for mixing and spooning out
the inks, and square-ended plastic scrapers for clearing ink off your screen and squeegee.

In the middle of the table is a little water bucket for spoons or spatulas dirtied while mixing, or for
small empty containers to soak before washing at the sink. There should also be paper towels and
cleaning rags.

Containers of mixed inks can be taken to your printing area, but if you're using a straight-from-
the-jar Speedball ink, and other people may be printing, please pour some ink into a bowl, to leave the
quart jar available for the next person. Inks can be returned to the quart jars if not mixed with
transparency or other colors.

Paper supply

Thin paper, such as regular drawing paper, rumples with the use of water-based inks, so | supply the
class with white posterboard, most of it cut down to half-size (14x22”) and quarter-size (11x14”). We
save misprints, and print on the backs of them while testing out colors. We even save posterboard
printed on both sides, for testing transparent color overlays or for creative collaboration.

Besides the white posterboard, we also have some Bristol Board, which is about midway between
posterboard and professional printmaking paper, in quality and price.

Otherwise, if you want to print on 100% rag printmaking paper, colored paper, fabric, or anything
else, you are very welcome to bring it to class.

Hair dryers
We generally have a couple of hair dryers plugged in, one near the clean-up table and one, on a long
cord, under the screen-drying racks.

Cupboard

In our big cupboard you can find fabric inks, crayons, transparent film, miscellaneous painting and
drawing supplies, spare inks, ink strainer, and anything we have that is not already out on a table.
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GENERAL CLEAN-UP GUIDELINES:

Clean the ink off your screen as soon as possible after printing.

Look for drips of ink on your tabletop and wipe them off.

By salvaging as much ink as possible from screen and squeegee into original jar or a mixed-ink
container, and scraping any remaining ink into trash can, you should be able to avoid getting much
ink in sink. If you see ink in sink or on faucet handle, rinse it down.

Clean outsides of bowls as well as insides, since they stack, and inks can redissolve.

Wash all five edges of squeegee blades, and handle if needed. Check where blade meets wood, and
be especially careful if ink happens to be squeegee-colored. In class, return clean squeegees to cart
once they stop dripping. Store them blade-side up, arranged by size, if possible. When picking a
squeegee, wipe it dry if it's wet. Especially check for any wet ink seeping from under handle.

When spray-cleaning ink off your screen (at sink, NOT at power washer!) reduce splashing by
spraying downward into sink, and always toward corner of wall. Most ink will be on “printing side” of
screen, but spray out briefly from back “flat side” as well.

Use scrub brush if needed to remove ink, and spray on a little Simple Green if ink has dried on
screen or has left a very dark stain. Check both sides of fabric and frame for ink; take care to remove
ink from inside edge where squeegee rested.

Keep rags free of stencil-removing cleaners or even Simple Green (which eventually dissolves
Screen Filler blockout). This is so rags can be safely used to wipe ink off screens, and to remove the
blue resist part of stencils without removing Screen Filler. If you do get cleaner on a rag, rinse well.
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JUMPIN

Before spending time planning layers of stencils, the best introduction to the medium is to just start
printing. Here are the basics.

Make a simple cut stencil

1.

Conceive plan. Sketch your design on scrap paper at full size. Decide which areas you want to
print and which you want stencil to block.

Take a length of freezer paper about the size of your screen, and tape to cardboard, with shiny
(plastic) side up. Draw on it, place sketch underneath as cutting guide, or cut freehand. Do not
cut directly on your printing surface with an X-acto knife. Alternative cut-stencil materials
include Con-Tact paper and Mylar. Regular paper rumples.

Cut out and discard parts that you want to print; what remains is your ink-blocking stencil, which
may include unconnected pieces called “floaters.”

Tape edges of freezer wrap to underside (flat side) of screen, with shiny side of freezer wrap
TOWARD THE FABRIC. To apply floaters or to secure very floppy parts, use double-sided scotch
tape. (Or cut floaters from Con-tact paper.) Try to keep scotch tape at least 1/4” from edge of
stencil, and don’t use rolled scotch tape, because too-thick stencil makes it hard for squeegee to
contact paper below. Good contact is needed to lay down a clean-edged deposit of ink. Stencil
need NOT be thoroughly taped to screen; ink will adhere it as soon as you start to print.

Hold screen up to light to check edges: If light goes right through, so will ink. Mask out with tape
or contact paper anyplace squeegee may pass or rest.

Prepare to print

1.

N S kA wN

Get some paper—as much as you want to print on, plus a few sheets of scrap.

Pick a squeegee, and get a block of wood, plastic scraper, & paper towel or damp rag.
Clamp screen in place. Use block of wood to raise screen.

Register paper at 2 corners, using 3 pieces of triple-layered colored tape, as dsemonstrated.
Choose or mix ink(s); bring to your table with spatula or spoon for each.

Ensure that paper is under screen, against registration guides.

Scoop a line of ink about an inch thick onto screen, past the far side of the open [unblocked] area.
To fade two colors together, overlap them and stir with squeegee.

Print

1.

Fan out your fingers, hold squeegee at about a 30 - 40 degree angle from upright, and use firm,
even pressure to pull ink across screen toward yourself. When you get to the frame, use squeegee
to carry ink back across image, then pull it a second time. This time leave squeegee resting at a
slant, against raised end of frame. Lift screen, place block of wood under either side of frame, and
remove print. Don’t worry if it sticks to the screen; just pull it off.
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An alternative to the 2" pull is “flooding”: With screen raised, pull squeegee gently toward
you to “flood” fabric with a thin film of ink. Lower screen and immediately pull ink across. Quite
often, EXCEPT for cut stencils, a single pull with no flooding will be fine, but many printers always
flood. Some flood front-to-back. Don’t leave flooded or just-printed screen lowered onto paper
except while immediately printing, or paper will get damp and rumple.

Adjust color if needed. Ink will start to dry and clog the screen after a minute or two without
printing, so if you stop to mix a new ink color, come back and print onto scrap paper every 2
minutes. If ink does start to dry in screen (looking hazy on paper), print onto scrap paper, pressing
squeegee back and forth several times to scrub out the drying ink. As you do this, ink may squish
out beyond edges onto the back side of your stencil, so print once more onto scrap to clear it off.

3. Print all copies and place on racks to dry. Print at least 6 copies; 8 or 10 if you like it a lot or plan to

add other colors.

Clean up

1.

When finished, raise screen and scrape off ink. Return unmixed colors to original jars. Save mixed
inks in containers; look for one with a similar color, and mix yours into it. Any last bits of ink that
can be scraped off can just go in trash, to avoid putting ink down sink.

2. Unclamp screen. Discard cut stencil.

3. Rinse screen and squeegee at sinks. Always wash ink off screen right after printing, especially if it is
straight out of Speedball jar; some inks can become impossible to remove from the mesh if they
remain on screen too long.
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PHOTO EMULSION STENCIL

Prepare transparent positive: Use the laser printer just outside our classroom at the Art League,
or another copier, to print a transparent positive of a photograph or other art onto transparent film.

Alternatively, draw or paint on wet-media acetate or copier film using opaque black marker, black
ink, or other black drawing tool. Or cut shapes from dark-colored or heavy-weight paper.

The parts of the image that are opaque or black will be the parts of the stencil that are open, to
allow printing ink through. Because each point on the screen must be either blocked or open, high-
contrast images, or other strong black and whites, are easiest to reproduce; grays can be unreliable.

Photoshop, if you happen to have it, allows various ways to turn hard-to-expose grays into black
and white, including a half-tone process. But don’t be fooled by “Halftone effect”, which in some
versions produces useless GRAY dots instead of the black dots of a true half-tone. Photoshop costs a
fortune, but there are other, cheaper and even free programs that can do some of the same work.
GIMP (gimp.org) is a free, open-source program that you may want to try.

We have lately been experimenting with different types of transparent film. Clear laser film makes
a lighter copy with a peculiar texture in the solid black areas, at least on our copier. “Kimodesk” strikes
a good balance, while “Super Black”gives the strongest blacks, sometimes going so far as to spread out
slightly or be too dark overall. “Casey’s Translucency” (“Better than Vellum”), our latest discovery, is a
lovely surface for drawing on, and reproduces blacks very well.

If a transparency is too light, another possibility is to make a second copy on clear film and tape
them together, making sure they are precisely lined up.

An additional control that you have with our copier is the “density” setting. Between that and
your choice of film type, there might be quite a range of how dark your transparency comes out.

Sometimes it’s interesting to play around with those choices, and make one dark copy and one
lighter copy, and use them both, as two separate layers on your print. Pick a lighter color of ink for the
copy that has the most areas of black, since that ink will print anywhere there’s any color at all. Then
print with darker ink the stencil that has less open area, to accent the darkest parts of the image.

| haven’t figured out how to use wi-fi with our printer, so you have to copy from something that
you bring or create on paper. To print an image from your phone or a thumb-drive, go to FedEx
Office, (a few blocks from class on Washington Street) or elsewhere.

Another limitation of the school copier is that it can only print 8% x 11”. Two or more sheets of
8 x 11” can be pieced together, as one way to work larger. | can supply you with a few sheets of 11 x
17" laser film to take to Fed Ex, but sometimes they don’t want to use it; some of their machines don’t
take it, and they've had trouble in the past with jamming due to excess heat. Some professional
printing places, like ABC Imaging, will do a nice job with much larger transparencies, but at a
considerably greater expense.

Many home-computer printers can print onto transparency film, but check in the owner’s
manual, and also be sure to use the right kind of transparency film. Inkjet film is the only thing that
doesn’t smear with inkjet printers. Otherwise use one of the laser films; take a few sheets from class.

To see detailed instructions for different approaches to creating transparencies in Photoshop and
GIMP, please refer to the next section of the handbook, “Creating Photo Transparencies on the
Computer.” Other graphics programs likely offer similar capabilities.

ALTERING A TRANSPARENCY: Any transparency you have made can be altered. That’s pretty
obvious if you are drawing, painting, or screen printing the transparency by hand. But it’s equally true
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when it’s a print-out from a computer or copying place. You can almost always remove black with
Exacto knife or rubbing alcohol, and you can always add black with brush, marker, or heavy paper.

Mix Diazo Photo Emulsion with sensitizer: (Ifit's not already mixed) Measure out 1/4 cup=4
tablespoons=2 oz cold water, or use an old sensitizer bottle as a measure, filling 3/4 full. Open the
small bottle of sensitizer, which you will find almost empty, except for a tiny bit of almost black,
highly concentrated sludge in the bottom. Add about 1/3 of your measured water to the sensitizer,
shake well, and pour into the big quart jar of light blue emulsion. Now take a small paintbrush and see
if there is any sensitizer still in the bottom of the little bottle. If so, add some more of your measured
water, stir, shake, and give it a little time to dissolve. Try again, until all sensitizer is dissolved. If it's very
stubborn, let it sit for awhile before you give up; it will likely dissolve eventually.. If gunk never did
stick to the bottom, just add the remaining water to the small bottle, shake, pour into emulsion, and
stir very thoroughly. The emulsion usually stays mixed for its lifetime, which is about two months at
room temperature or 6 months in the refrigerator. Stir it if it's bubbly on top, or skim out bubbles if it
seems like they’re starting to dry out.

Coat screen with emulsion: Lean a dry (all-the-way dry!) screen against the table, flat side
toward you, and use the scoop coater as demonstrated, raising it slowly and evenly upward as you
steady the top of the frame with your other hand. Never forget to tip back the scoop coater before
you lift it away from the screen, so that it doesn’t drip. (It may be a good idea to apply a second coat,
although we usually don't, since our screens are such fine mesh.) Then, | recommend using a small 2”
scraper to coat the edges where the scoop coater didn’t cover, so you'll not need to mask those parts
some other way. Hold the scraper almost perpendicular to the screen and work from bottom to top.
There should be just enough angle to keep it from bumping along. Much more angle will push
emulsion too heavily through the screen. (If you can see that a lot has come through to the other side,
remove the excess using a kind of “snow plow” move with the scraper, to lift off emulsion rather than
just pushing it back through to the first side. )

If a scoop coater is unavailable, use a large plastic scraper (8 or 10”). Start with the screen
horizontal, coating as evenly and thinly as possible. Then set the screen on edge, check the other side
and smooth it out if necessary.

With a paper towel or small scraper, wipe any excess emulsion from the frame.

Dry the screen in the dark, with a low-speed fan, 45 minutes or longer. Without an exhaust fan, it
might take longer. You should no longer be able to feel the coolness of continuing evaporation. (If
darkness is total, you may wait a day or two before exposure, but at class, the exposure needs to be
done the same day.)

At this point, the emulsion is dry but not hardened.

Expose screen: Place the dried screen printing-side up on black-covered foam rubber, centered
directly under the photo lights. Set transparent positive(s) onto the screen right-side up. If you have
two transparencies that will be printed separately, place one at each end of the screen. Place the
bottom or a side edge of each transparency facing the end it’s near, so you will always be able to print
from the near end, not way up at the hinge end. It's important to allow 3 - 4” at each end for the
squeegee to rest; resting the squeegee on the image makes a mess. Double-check that your
transparencies are all right-side up; make sure you can read any writing!

| used to advise placing the screen flat-side up for exposure, but have come to find that practice
needlessly complicated.
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Place glass over the transparency to keep it tight against the screen; good contact is critical. If the
glass does not readily fit inside the frame, you will need to set the screen printing-side down after all,
and reverse your transparencies.

Turn on the light(s); we use a bank of three 500-watt halogens but two would do fine, for our 23 x
31" screens. Set the timer; usually between 3% and 4 minutes with our current set-up.

The light (and heat) will harden whatever it can reach, while what's blocked by the opaque parts
of your positive will remain soft and water-soluble.

Too-long exposure will cause light to creep around the edges of your blocked areas, wiping out
fine details by hardening them. (For a stencil with lots of fine lines, you may want to shorten exposure
time by 15-30 seconds). With too-short exposure, the emulsion won’t harden properly and too much
will wash away. A double coat of emulsion may require a slightly longer exposure. If the glass is still
quite hot from the previous exposure, cool it by fan before using, or the heat may partially expose
even your blocked areas. We have two pieces of glass; choose the cooler one.

Other variables: Older emulsion exposes a little bit faster than fresh emulsion. Also, if using
Kimodesk transparent film, vellum, or frosted Mylar, instead of a totally clear sheet, it could take a
little longer to expose, although in practice, it often doesn’t seem to make much difference. However,
avoid overlapping two layers of non-clear film.

Wash out unexposed emulsion: When time is up, carry screen to washout sink. At class:
1. Stand screen in corner sink, flat (under)side toward you, printing side toward corner.
2. Reach over screen to evenly wet other side with a quick spray of lukewarm water.

3. Now thoroughly spray flat side, to wash out unexposed emulsion and form your image. If the
nozzle is adjustable, start with a gentle spray. Aim water down into sink and toward corner of
wall. Unless it washes out really quickly, you can expect to need a more forceful spray, to
complete the job. If it helps, you can flip screen and spray other side too. Continue spraying until
all unwanted emulsion is gone. Hold screen up to light to make sure.

NOTE: If just a little emulsion lingers, where it doesn’t belong, try rubbing with a paper towel or
(gloved) fingers, and spray some more, perhaps with hotter water; but watch carefully, and stop if you
start to lose emulsion where you want it to stay.

If emulsion is not washing out well overall, or a few stubborn parts remain blocked, you may
CAREFULLY try the power washer, with instructor’s help. Aim down, not toward screen as you start;
then always keep spray moving across image, not too close to fabric. (At full power, pressure washer
can easily force ALL emulsion off screen!) If power washer is adjustible, use lower power, or wider fan,
at first, gradually increasing pressure till it’s effective.

Dry Screen: Only when you’re SURE emulsion is removed to your satisfaction, dry both sides of
screen: Gently blot with paper towels, then use hair dryer if you want to print soon. Always hold dryer
at least an inch or two from fabric. Be gentle with emulsion along edges, where it’s likely still a little
soft. Hair dryer will help harden it.

Check the stencil: Hold it up to the light, looking for pinholes and other glitches that will permit
ink to print where you don’t want it. Commonly, there is a “glass line” where one or more edges of the
glass blocked just enough light to keep emulsion soft, so that it washed out. If the line is on the
polyurethaned edge, it won’t matter. Otherwise, a wide piece of masking tape on the underside of the
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screen should take care of it. Harder to see but sometimes an issue are tiny lines corresponding to the
edges of your film. Other pinholes can be caused by dust on the glass or screen.

Screen Filler block-out on a paintbrush is best for touching up anything within half an inch of the
image, or a few scattered pinholes. Larger areas can be blocked with contact paper if you prefer.

For pinholes, the contact paper is best put on the underside of the screen, so that the squeegee
won't start lifting its edges. But contact paper is also good for when you have multiple images on a
screen, and you want to block out whatever you're not printing. In this case | recommend putting the
contact paper on the top (printing) side of the screen so that ink will not dry in and clog those other
images that you wish to print later.

Print: One thing to watch out for, with photo stencils having fine details or delicate half-tones, is
their sensitivity to how much ink is put through the screen. If areas of fine detail are drying out, so
that ink doesn’t go through onto the paper, first dissolve the dried ink: flood the screen, leave it raised
for a minute and then print a couple of passes onto a piece of scrap paper. Make sure the ink is
cleared from the screen. Then, try changing to a duller-edged squeegee, or using a floodstroke or two
passes. Conversely, if dark areas are losing detail because ink is finding its way around tiny pieces of
emulsion, switch to a sharper-edged squeegee and/or try using just one pass. Before you resume
printing on your good paper, first print onto scrap paper to press off the excess ink which will have
gotten onto the underside of your stencil. Read more details in the “Trouble-Shooting” section.

Clean Up: After printing is completed, clean the ink off as soon as you can. If there’s a lot of ink to
clean off, carry your screen to the sink and spray it out. For a small area, sometimes it’s easier to bring
wet rags to your table and wash out the ink that way, especially if you're about to print again. Make
sure to wipe dry the screen and table before further printing.

Ink stains on the EMULSION are not a problem. If ink is actually clogging the screen mesh, or
badly staining the fabric itself, wipe on Simple Green and then rinse with warm water. Simple Green
will NOT affect photo emulsion.
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TO REMOVE ALL PHOTO EMULSION AND RE-CLAIM SCREEN

When you are certain that you won’t want to print the same stencil again:

1.
2,

Towel dry screen, if you have just rinsed ink off the screen, so as not to dilute emulsion remover.

Set dried screen onto wooden supports at table by sink. Wearing gloves, pour a little DIAZO
PHOTO EMULSION REMOVER onto screen (not on an open area). Spread with large paint
brush or paper towel .

Wet other side the same way. Scrub briefly on both sides, especially near image.

After a minute or two, apply a little more emulsion remover, if screen isn’t thoroughly wet. Scrub
a little more, if stencil has been on screen awhile.

Spray with POWER WASHER, flat side of screen toward you to reduce splashing. If pressure
washer is adjustable, start somewhat gently and add more power as needed. If not adjustable, (as
ours is not, in 2022) you can control it by how close you hold the nozzle to the screen. Holding it
close can blow through the polyurethane | painted around the edges, so try to be careful there.
Turn screen upside down mid-way, if it gets hard to reach, and as a last step, reverse it to clear the
cleaner off the edges of the other side from the screen, holding the nozzle at a distance.

Hold to light and check carefully that all emulsion is gone. If there is a small stubborn area,
use full force with nozzle almost touching screen. If a good bit of emulsion remains, reapply
remover and spray again.
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CREATING PHOTO TRANSPARENCIES ON THE COMPUTER

| am grateful to Charles Robertson for the information in this section. Charles and Tim Lovelace run
Sediment Press in Alexandria. (www.sedimentpress.com) They met some years back when they both
took my class. It turned out they had a few things to teach me.

Monochromatic Halftoning in Adobe Photoshop

Like with most things one does in Photoshop, it is best to begin with a high resolution image. If
scanning a photograph, scan it at the highest resolution you can.

Open your image in Photoshop.

Save it as a new file in PSD format. This is important because once you halftone your image you will
not be able to reverse the process.

Flatten your image (if it has more than one layer):
Go to the menu Layer > Flatten Image

Resize your image:

Go to the menu Image > Image Size...

Set the Document Size Width or Height to the desired measurement of your final transparency (and
silkscreen image).

Set the Document Size Resolution to 600 Pixels/Inch.

If the image then is not the right size on your screen, go to the menu View. Hit “print size” or
whatever size you want it on the monitor.

Grayscale your image: Go to the menu Image > Mode > Grayscale
At this point, you can use the Layers palette to adjust contrast, brightness, etc. If you do, save it, and
then flatten your image again.

Halftone your image:

Go to the menu Image > Mode > Bitmap...Your Output Resolution should be the same as your Input
Resolution: 600 pixels/inch.

Under Method select Halftone Screen. Hit OK.

For Frequency try 25 Lines/Inch. If your screens are well coated and your exposure is right you could
use a frequency up to 50 Lines/Inch perhaps. The higher the frequency the smaller your halftone
dots. [Nancy’s note: I've read it’s best to avoid a line frequency that’s a multiple or factor of your
mesh size. So, for 230 mesh fabric, avoid 57-58 and 29 LPI; for 195 mesh, avoid 47 and 23-24 LPL.]

For Angle choose 45 degrees or any angle you like. 30 degrees may work well, too.

Set the shape to Round.
Hit OK.
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You have converted your tonal image into hundreds of thousands of little black and white dots. If
you want to try other halftoning settings, select Edit > Undo. Otherwise save your image and print
your transparency.

To expose half-tone transparencies:

The mesh of your silkscreen fabric can interact with the pattern of dots on a half-tone, to create a
“moire” effect, (sometimes looking like the swirling shapes you see on the folds of sheer curtains).
Before coating your screen with emulsion, or else testing with another screen having the same type
mesh, try placing your transparencies at slightly different angles, and choose an angle that has little
interference. This problem is all the more complicated if you plan to print layers of half-tones, which
need to be at different angles to each other.

Posterization for Screen Printing in Adobe Photoshop

Posterization is the process of separating an image into bands of solid tones. These instructions will
show you how to posterize an image and separate it into layers for screen printing such that the
darker colors will print entirely over the lighter ones, with lightest color printed everywhere you don’t
want to keep white. That saves the need for trapping and exact registration in your final screen print.

Open your original image in Photoshop.
Save it as a new file in PSD format.
Flatten your image: Go to the menu Layer > Flatten Image

Resize your image:

Go to the menu Image > Image Size...

Set the Document Size Width and Height to the measurements of your final image.
Set the Document Size Resolution to 600 Pixels/Inch

Grayscale your image:
Go to the menu Image > Mode > Grayscale

Posterize:

In the Layers palette, double-click on the Background layer.

Press OK to convert it to a regular layer.

Set the opacity of the layer to 50%.

Go to the menu Layer > Add New Adjustment Layer > Threshold... Hit OK.

Adjust the slider far to the right. This will determine the shape of your lightest color.

In the Layers palette, ALT + click (on PC) or Option + Click (on Mac) the line between Layer 0 and
the threshold layer. The adjustment layer should show an arrow pointing to the layer below. This
instructs the adjustment layer to only affect the layer directly below it.

In the Layers palette, select both Layer 0 and the Threshold 1 layer by clicking on Layer 0 and SHIFT +
clicking on Threshold 1.
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(posterize, cont.)

Press CTRL+) (on PC) — or CMD+J (on Mac) — to duplicate the layers. [Nancy’s note: If CNTR+)

doesn’t work on your pg, as it doesn’t on ours with Photoshop 5, instead Right Click and choose

Duplicate Layers.]

Repeat to create as many levels of posterization as you want. If you want to make a four color print
you should have four image layers each with their own threshold adjustment layer.

In the Layers palette, click on the Threshold layer for the first copy you made (labeled ‘Threshold 1
copy’).

Adjust its slider left to determine the shape of your next-to-lightest color.

Adjust the rest of the Threshold sliders left in succession to determine the shapes of the other color
layers. The top layer should be adjusted farthest to the left and will be your darkest color.

Using the slider, readjust any layers you want to. Understand that you will ultimately choose the ink
color for each layer, and will not be stuck with the balance of values (darks and lights) shown on
the monitor. Just make the break points where they best suit your image, in terms of lines and
shapes.

Save your file.

To Print onto Transparent Film:

Turn the opacity of all image layers to 100%.

Print the file on a transparency.

Turn off the visibility of your top image layer by selecting the eye symbol next to it in the Layers
palette.

Print the file to a transparency.

Turn off the visibility of the layer you just printed and print the next layer.

Repeat until you have printed all your layers.
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Monochromatic Halftoning in GIMP

GIMP (GNU Image Manipulation Program) is a free, open-source program, with many capabilities
similar to Adobe Photoshop. Originally created by Spencer Kimball and Peter Mattis as a semester-
long project at Berkeley in 1995, it is run by a self-organized group of volunteers. At one time, you
needed a LINUX-type operating system to use it, but now it works with Microsoft Windows and many
other operating systems.

Begin with a high resolution image. 300 pixels per inch is a good benchmark.
Open your image in GIMP
Save it as a new file in XCF format.

If you have not done so already, set the ‘Maximum new image size’ to 1024 Megabytes or higher
under the Environment tab in Preferences.

Go to the menu Image > Mode > Grayscale

Resize your image:

Go to the menu Image > Scale Image...

First set the X resolution’ and ‘Y resolution’ to 600 pixels/Inch.

Then set your Image Size Width and Height to the final printed size of your image.

Halftone your image:

Go to the menu Filters > Distorts > Newsprint

Use the following settings:

Input SPI: 600

Output LPI: 25.0

Cell size: 24 (be sure to press Tab after entering the cell size otherwise it might default back to 10 and
give you tiny tiny dots that you can’t screen print)

Angle: 45

Spot function: Round

Press OK

You have converted your image into hundreds of thousands of dots that simulate tone. Print your
image to transparency to expose and screen print.

[See notes on “Halftoning in Photoshop” regarding LPI and angle.}
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Posterizing for Screen Printing in GIMP

Please see note on page 15 about posterizing for screen printing.

Begin with a high resolution image. 300 pixels per inch is a good benchmark.
Open your image in GIMP

Save it as a new file in XCF format.

If you have not done so already, set the ‘Maximum new image size’ to 1024 Megabytes or higher
under the Environment tab in Preferences.

Go to the menu Image > Mode > Grayscale

Resize your image:

Go to the menu Image > Scale Image...

First set the X resolution’ and ‘Y resolution’ to 600 pixels/Inch.

Then set your Image Size Width and Height to the final printed size of your image.

Posterize your image:

Go to the menu Tools > Color Tools > Posterize...

Set Posterize Levels to the number of colors you want to print plus one. If you want to make a 4 color
print then set Posterize Levels to 5. (assuming you are using the paper as your lightest color)

Separate for screen printing:

In the Layers palette right-click on the image and select Duplicate Layer from menu.

Repeat until you have as many layers as colors for your final print. If you want to make a 4 color print
then you would have 4 layers.

Select the top layer in the Layers palette.

Go to the menu Tools > Color Tools > Threshold...

In the histogram you will see bars that separate empty spaces. Each of those empty spaces represents
a color in your final image. Drag the slider so that it is in the leftmost empty space and press OK.

The resulting image is your darkest color.

Print the image to a transparency.

Turn off visibility for the top layer by clicking the eye symbol next to it in the Layers palette.

Select the next layer down and run the Threshold color tool on it.

Drag the slider to the second empty space from the left and press OK.

The resulting image is your next-to-darkest color.

Print the image to a transparency.

Repeat the process starting with turning off visibility for the current layer until you have printed all
your layers to transparency.

Save your file.
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BLOCK-OUT STENCILS

The concept: There is a family of four types of block-out stencils, all using Speedball’s brick-red
Screen Filler as the final ink-blocking stencil, with occasionally the addition of WAX crayon.

The thin blue “Drawing Fluid” and WATER-SOLUBLE crayon both dissolve in water, so will not
block water-based inks, and are not part of the final stencil, but are used in the resist process. “Resist
is used when you want to draw or paint the area where the ink WILL go through, rather than the part
you want to block out.

Any and all of the four types stencil can be combined, though areas having resist need to be
somewhat separated from those that don’t.

If you paint with Screen Filler to block some parts of a photo stencil, you will be able to remove
the Screen Filler without removing the photo stencil, since they take different cleaners to dissolve.

”

HOW TO DECIDE WHETHER OR NOT TO USE RESIST:

Basically, you'll probably want to do whatever’s more natural and less work, for any given stencil. Ask
yourself, which is a more comfortable process for you and best suited to your image:

o The one-step method of directly blocking, with the red block-out, everywhere you want NO ink
to pass. For large areas, use stiff plastic scrapers, not a brush. Check for pinholes and lumps, and
dry well before printing, using hair dryer if you want to print soon.

—OR-
» The 3-step resist technique: (hair dryer can be helpful at each step).

1. Use the blue Drawing Fluid and/or water-soluble crayon to paint or draw on the screen exactly
the parts where you DO want the ink to go. If you want to print a word, paint the letters, not the
area around the letters. Hold to the light to make sure crayon blocks the screen where you want
it to, or to check the blue stuff for pinholes. Dry.

2. When dry, carefully coat the screen with a THIN FILM of red Screen Filler, in one pass if possible,
with a wide scraper. Get instructor’s help the first time you do this. The Drawing Fluid or crayon
will “resist” the Screen Filler, preventing it from lodging in the fabric.

3. After red blockout is COMPLETELY DRY, use two clean rags wet with cold water to dissolve your
resist, setting the screen on its edge and rubbing from both sides at once.
Or spray out at the sink with cold water, but that will add drying time, if you're about to use the
stencil. Once it’s dry, you're ready to print.

GETTING STARTED:

Tape your “master drawing”, or the print-in-progress, into 3-point registration guides. You can use
these same guides for printing as well as for making the stencil. Protect drawing with wax paper or
clear film if you wish.

Always raise your screen after outlining (with 1/16” brushstroke or with pencil) areas you want
to fill in with either the red or blue liquids. With the screen down flat, both fluids are inclined to
glue the screen to the paper, or lodge in the paper or film instead of in the screen fabric.
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DIRECT BLOCK-OUT

Using paintbrush and plastic scraper, fill the screen with Screen Filler block-out (“the red
stuff’), wherever you DON'T want the ink to pass through.

Screen Filler must be thoroughly stirred if it hasn’t just been used. If your first strokes look kind of
thin, they may need touching up later, in order not to let printing ink through.

First: If you're working from a master drawing or adding a layer to a print already begun, set the
screen down directly on it, so that you can see it right through the fabric. Register image (see page
45), tape it down, protect with plastic film or wax paper if you wish, and clamp screen into place.
There are now three possible ways to proceed.

Alternative #1: The first option is to trace relevant lines from your drawing onto your screen in
pencil. (Not too dark; the pencil may show on the first few copies you print.) Then, RAISE SCREEN
and, with a paint brush, apply Screen Filler to the areas that you want to block, that is, painting
AROUND the parts that you want to print. To fill large areas, use a square-end plastic scraper, pulled
like a squeegee at a 30 - 40 degree angle. Block the screen all the way to the edge, anywhere the ink
might pass. (If you want to reserve half of your screen for a separate stencil, leave that half open for
now; it can be masked with freezer paper or contact paper before printing.)

In applying Screen Filler, learn to use a light touch with your brush and scraper. You don’t want to
push the filler through the screen, but only spread a thin, even film on top of it. Some Screen Filler is
likely to seep through the mesh anyway, so before it dries, check the back of the screen and use
scraper or brush to smooth out or remove it from places it has pushed through heavily. (Big lumps
slow drying, affect printing, and make the stencil harder to remove.)

Alternative #2: You can save a step and gain precision by tracing your drawing onto the screen
directly with Screen Filler rather than pencil. The drawback is that the Screen Filler tends to push
through the fabric and stick to your paper instead. (Even if you protect your original, the Screen Filler
will glom onto the protective layer instead of properly filling the screen.) Using a very light touch,
outline the areas you want blocked with no more than a 1/16” brush line of Screen Filler.

After outlining, raise the screen. Now widen the outline with more of the red, using a bigger brush
or straight-edged bit of heavy paper, such as posterboard
. Fill in any small areas that are to be blocked. Use plastic scraper for large areas, as explained above.

Alternative #3: If you favor lively brushstrokes over precision, raise your screen just a little, with a
pencil or scraper. Looking straight down and keeping your head still, you can pretty well align your
brushstrokes with the drawing underneath. Check to make sure nothing’s touching the underside of
the screen; it’s still a good idea to raise the screen higher for filling in large areas.If you want to paint
or draw totally freehand on the screen, that’s fine too.

Finally: Let the screen dry; a hair dryer will speed it along. When it is dry enough to touch, hold
screen up to the light and repair any skips or pinhole that the light can pass through, if you don’t
want ink to do the same. The stencil must be completely dry before printing, or it will disintegrate.

WAX CRAYON applied to the screen also blocks the ink somewhat, useful for soft edges or
texture rubbing. (But it’s sometimes hard to remove.)

Draw directly onto the screen with crayon or china marker to softly block areas that you DO NOT
wish to print. (Use Screen Filler, instead, for large areas.)
Note the difference in smoothness of the line when you draw on a raised screen, as opposed to a
screen lowered onto paper; use whichever you like best.

Texture: One way to use crayon, besides freehand drawing, is to make a texture rubbing by
setting a relatively flat, textured item directly under the lowered screen and rubbing over it. (Don’t
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use something so sharp as to cut the screen; sandpaper is borderline, but can be very safely used with
a layer of wax paper over it.)

Good for highlights, textures, and various soft effects, crayon is not suitable for blocking large
expanses, so use in conjunction with another stencil technique. In case small specks of crayon may be
pressed through the screen onto your image during printing, choose a color of crayon that won’t
show much. Also, check the underside of the screen for loose particles of crayon before printing,
Crayon works best on a screen with a fine mesh, like the yellow 230-mesh screens in the classroom.

Wax crayon is useful for last-minute changes, since you don’t have to wait for it to dry. You may
even add it during printing. It can be the best choice to block pinholes near the image on the fly. But
be careful, since it can hasten disintegration of a stencil that is already fragile or breaking down to rub
it with crayon while damp. If this starts to happen, you'll have to block pinholes with tape instead, if
possible, or clean the ink off as gently as you can and then repair the stencil with Screen Filler.

RESIST/BLOCKOUT STENCIL

Paint or draw whatever and wherever you DO want to print, using the blue Screen Drawing
Fluid and/or water-soluble crayon. When the fluid is dry, those parts will resist a thin coating of
red Screen Filler spread over the entire screen.

Then, after Screen Filler has dried, dissolve blue Drawing Fluid and/or water-soluble crayon
with water. The red Screen Filler block-out remains as your stencil, allowing ink to pass through
the parts where you painted or drew.

Painted resist: As with the painted block-out stencil, you can choose whether to trace your
drawing in pencil or outline it directly with a small paintbrush. But this time, you will use the blue
Drawing Fluid to paint the parts that you DO want to print, (instead of painting red Screen Filler on
the parts you want to block out). To avoid gluing the screen to your drawing, use a light touch and a
fine brush-line when outlining, and raise screen from the drawing before you fill in the outlined areas.
Again, if you want to work a little more loosely, skip the outlining and paint with the screen raised
only slightly, resting on a scraper or pencil or something, just enough to keep the screen fabric held
away from the paper or film below.

After all parts that you want ink to pass through have been filled in with blue, hold screen up to
light to check for pinholes and near-pinholes. (Watch for drips!) A too-thin coating of Drawing Fluid
may not resist the red Screen Filler. Where in doubt, add Drawing Fluid to front of screen. When it’s
dry, check again for pinholes. Use hair dryer to speed drying.

Drawn resist: If you want your stencil to look more like a drawing than a painting, draw with
water-soluble crayons (or lithographic pencil) instead of painting with the blue Drawing Fluid. Again,
you will draw in the areas that you DO want to print. You should draw fairly dark, in order for the
crayon to resist the red Screen Filler. Hold screen up to light to make sure water-soluble crayon is
actually blocking the fabric. Large areas can be filled in with Drawing Fluid.

Water-soluble crayon can be used in much the same ways as wax crayon, including texture
rubbing as well as free-hand drawing. The difference, of course, is that with water-soluble you draw
what you want to print, instead of what you want to block. Water-soluble crayon can not be your
final stencil! Nor is it a good choice for filling in large areas; use Drawing Fluid for that.

If you are hoping for a soft edge with the water-soluble crayon, a coarser mesh is better than a fine
mesh. If your screen is 230 mesh, borrow one of the communal screens that’s coarser.
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To flood: Please do this step with the help of the instructor if it is your first time. When
Drawing Fluid is thoroughly dry, take a plastic scraper, preferably wider than the entire area to be
printed, and coat the screen with red Screen Filler, right over top of the Drawing Fluid, and on the
same side of the screen, pulling the scraper at a 30 - 40 degree angle like a squeegee. Coat it in one pass
if you can, and especially avoid more than two passes, since the blue stuff will start to dissolve. Use a
smooth, light touch with the scraper; see hints in “Direct Block-Out” section. When you turn the
screen over to smooth down any Screen Filler that has seeped through, DO NOT coat the back side of
the blue parts with the red; this sandwiching could prevent the removal of the blue.

To remove the resist: Once the Screen Filler has completely dried, use cold water to dampen
clean rags, and wash out the blue by rubbing from the front and back of the screen at the same time.
Most of it should come out easily, but if the red is heavy in places, you may need a fingernail or
toothbrush to remove it, or a hard spray of COLD water at the sink. (Hot water is likely to wash out
some of the Screen Filler along with the resist.

With either Drawing Fluid or water-soluble crayon, if all else fails, a careful dabbing (from both
sides) with rubbing alcohol on small folded squares of Kleenex may succeed, if you manage to stop just
short of dissolving the parts you want to keep.

(Alcohol, used this same way but with a little more force, is a general eraser for any small unwanted
areas of Screen Filler; an alternative is carefully-applied, diluted Awesome cleaner.)

Although it involves more steps, the resist process can feel like a more natural way to create an
image. Just always remember that the final stencil will be the red Screen Filler, the same as a direct
block-out stencil.

EXPERIMENTS WITH BLOCK-OUT AND RESIST/BLOCKOUT STENCILS

If you just want to experiment, to get a handle on block-out techniques before you care too much
about the results:

Draw a few small simple things on a piece of sketch paper — a few shapes, a few letters; it doesn’t need
to add up into an image.

Take a clean screen and, in your imagination, divide it into three sections.

Section 1. Drawn Resist:

Pick out some textured items, set them under the screen and rub over them with water-soluble
crayon. Also draw some freehand crayon lines, both with the screen down and the screen raised. Hold
screen to light to see how much the crayon is filling the mesh. The textures and lines you draw will
ultimately let the ink through and will print, if there is enough crayon to resist the Screen Filler.

Section 2. Painted Resist:

Set your sketch under the screen (no need to register), With blue Screen Drawing Fluid on a small
brush, trace lines and outline the shapes you have drawn, aiming for a brushstroke no more than 1/16
inch wide. Every place you paint blue will eventually let the ink through and will print. Don’t use a wide
brushstroke or try to fill in areas, unless you raise the screen a little, because the drawing fluid will go
through the screen and stick to your paper instead of lodging in the fabric. It can be handy to make
some little notation on the areas you'll be filling in, in case it might otherwise get too confusing.
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Section 3. Direct Block-Out:

Set your sketch paper under the screen. Use a small brush again, this time with the reddish Screen
Filler block-out. (Stir the block-out if it is watery on top.) Every place you paint the red will block the
ink from printing. Learn how to make a 1/16 inch outline without the red stuff going through onto the
paper. Or, just trace shapes onto the screen with pencil, and raise the screen to do the painting.

Now, prop up the screen on wood blocks.

With the blue Drawing Fluid:

Fill in any blue areas that you have outlined. Use whatever size brush is easiest, with as light a touch as
possible. If much goes through the screen, try to pick it back up with your brush or absorb with a
Kleenex, so it won't take so long to dry.

Freeform: Also experiment with various freehand brushstrokes, and with other applicators such as
sponge, rag, ink pen, finger or palm.

With the red Screen Filler:

Fill in any shapes outlined in red.

Freeform: Play around with different brushes to try dry-brush, fan-brush, or splatter techniques, or
whatever you may think up. Check the back of the screen for any thick blobs, which you can smooth
down with the scraper or brush.

Tofill in large areas, use a square-edged scraper. You only need a thin film of red. Check for and fill in
any skips or pinholes.

Once blue drawing fluid is dry (use hair dryer if needed), with help of instructor, coat areas that
have this blue “resist” with an even layer of the red Screen Filler, all in one pass if possible. Avoid
areas in section 3 which are meant to remain open. This will be tricky if areas of resist are too close to
the painted block-out.

After Screen Filler dries, dissolve resist with cold water, on two rags or with sprayer in sink. | favor
the rags, rubbing the screen from both sides at once, instead of getting it wet all over again (unless
you're not about to print anyway, in which case that doesn’t matter.) You might have to rub a little bit
even if you spray it at the sink.

Dry again. Print, once or twice, using a large squeegee, onto one big piece of paper. Sometimes a part
of the experiment may be worth printing by itself or incorporating into a planned silkscreen.

CLEAN-UP: With any stencil, always clean ink off the screen right after printing. For a block-out
stencil, use cool or cold water if the stencil may be printed again, so as not to start to dissolve any of
the Screen Filler. Ink stains on the SCREEN FILLER are not a problem. If ink is actually clogging the
screen mesh, or badly staining the fabric itself, wipe on Simple Green and immediately rinse with warm
water. (Prolonged use of Simple Green will dissolve Screen Filler stencil.)
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TO REMOVE ALL BLOCK-OUT AND RECLAIM SCREEN

RED SCREEN FILLER dissolves with “LA’s Totally AWESOME” cleaner (or Arm & Hammer
Washing Soda, mixed % cup to a quart of water)

1. If you have just printed, rinse ink off screen first, and paper towel-dry wet screen so as not to
dilute cleaner.

2. Set screen on wooden supports at clean-up table. Wet both sides with full-strength Awesome
orange cleaner.

3. Briefly scrub both sides with scrub brush marked “red”.

4. Apply more cleaner. Let soak for 5-10 minutes. Longer will do no harm. More scrubbing will speed
dissolving where Screen Filler is thick. Before rinsing screen, make sure it’s all still wet (shiny) with
cleaner, and that there are no thick lumps that have not yet started to dissolve.

5. Spray out Screen Filler with power washer , thoroughly rinsing off all soapy parts of frame and
fabric. If you used the Screen Filler to modify a photostencil that you want to preserve, use the
gentler classroom sprayer, which may require longer soaking; the thick spots of the blockout need
to be pretty well dissolved.

6. If some red remains, wipe with more cleaner, scrub, and after a minute or two, spray out with
power washer. Screen Filler within 2 inches of frame, where you won’t print anyway, can stay.

WAX CRAYON or CHINA MARKER will be softened by the cleaner and may wash out with hot water
or power washer. Household wax-removing cleaners are also recommended. If needed, dampen small
squares of Kleenex with Turpenoid or Gamsol and rub fabric from both sides at once.
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PLANNING MULTI-STENCIL PRINTS

using transparent combinations

As you plan how many layers to print and in what order to print them, there are many decisions to
make. How many layers will depend upon how much time you want to devote to the project, how
many distinct colors you think you need, and how many of those colors can be the result of two
overlapping layers or else a color fade that changes from one end of the squeegee to the other.

As we have shown in class, a transparent second color can make two new colors, one on the white
paper and one where it overlaps the first color. A transparent third color can add four more new colors
to those three. Each time you add a transparent or translucent layer, you double the potential number
of distinct colors, plus one. The “one” is the new color on white paper.

This adds up quickly. Of course, you can’t pick what all those new color combinations will look like,
but | find it useful to be open to the possibility that some particular combination might work. If it
doesn’t, you can always add another color later. If the combination does actual harm, you may want to
block out the bad part before printing that layer onto the whole batch.

I've learned to be flexible in my planning, at least when it comes to transparent colors. | say to
myself, Maybe Color B on top of Color A will give me something | can use as color C. Or maybe it won't
work for all parts of color C, but | can print once in a lightish color that will look right in some areas.
Then, as a separate step, | can alter the stencil by blocking those parts out, and printing again the parts
where | want a stronger color, whether it’s darker, more vivid or more opaque.

It's true of transparent color combinations as it is of almost all aspects of screen printing (and
much other art-making) that it’s a long journey from what is pictured in your mind to what appears
on paper. If the picture in your mind is the sole goal, you are likely to fall dismayingly short. It’s just too
darn hard to control everything. Try to look with an open mind at what actually transpires as you
print, and welcome the “happy accident.” Let the process itself, and the look of a partially finished
image, help guide you. One thing that makes silkscreening (and other art-making) so exciting is that
possibility of actually transcending, at least in some way, the ever-elusive idea you began with.

subtractive vs. overlapping stencils

When you print a stencil and then block some parts out and then print it again, on top of the first,
the second one is called a subtractive stencil, or a reduction stencil. You can continue to block out
more parts to print further subtractive stencils. Working subtractively can save a lot of drawing, and a
lot of stencil removal. But if you use only reduction stencils, you will not benefit from any
combinations, chance or intentional, that would be made by transparent overlapping stencils.

When | say “overlapping stencils” | am referring to colors that overlap enough that the
combination color is a noticeable part of the image.

Another type of overlap is sometimes used if you are planning stencils that have one color
stopping exactly where another color starts. Overlapping them just a hair can avoid a tiny white line
between them, since | don’t know any way to achieve perfect registration in a silkscreen. This type of
slight overlap is called “trapping,” and can be done on computer as well as by hand. Generally, it’s the
underneath color that will be expanded, so that the upper layer has its edge just where you want it.
Trapping works best if the upper layer is a dark color or opaque, since a transparent color will make a
darker line where it overlaps, which could be just as annoying as a white line.

Then too, those skinny white lines, or other effects of printing colors slightly offset from each
other, can be one of the interesting characteristics of a silkscreen. Sometimes it’s a good thing for your
work to look hand-printed, and leave computerized perfection to computers. It’s really your decision.
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combining different types of stencils

For any given print, you can use various types of stencils; whatever is best suited to each layer. Just
as one example, you might start with an overall background layer, perhaps blocking out any parts
you'd like to leave white or print later with a light, bright transparent color. An open rectangle can be
easily made using any kind of stencil, if you just want a background color over the whole print.

You could then print a photostencil in a medium-dark color, defining your image and darkening
any shadowed areas.

Next you might use one of those 2-layer prints as a registration key, and add color to certain parts
of the image using Screen Filler block-out, on a clean screen or the other end of your same screen if
there’s room. | often suggest, if you have just one 8% x 11” photo transparency, to use the other end of
your screen to expose a piece of posterboard or black construction paper the same dimensions as your
whole image. When exposed at the same time as your photo transparency, this rectangle will give you
an open space to print as a background and/or partially block out with Screen Filler to add color to
just parts of the image.

After you've printed those colors, you may decide to revisit your photo-stencil. Use Screen Filler to
block out any places that are already dark enough, and print the parts you want darkest as a last step.

using a silkscreened image AS a transparency

In fact, using Screen Filler to block out parts of a photo-stencil is the way I've found photo-stencils
to be most useful in my own work. | usually hand-paint and hand-draw my stencils, and often plan
subtractive stencils, which can save a lot of drawing. But sometimes | wish | could see how the whole
stencil will look WITH the subtractive version, before | commit to printing anything onto the entire
edition. Until | got a photo set-up, that was never possible, but now | can print the whole block-out
stencil with straight black silkscreen ink onto wet-media acetate or any transparent sheet that won'’t
rumple or make the ink bead up. That black-and-clear print makes a very good photo transparency.

| expose this transparency to make an identical copy of the block-out stencil. Then | can make the
subtractive changes on either of those stencils, rather than have to destroy one version to create the
other. What's more, since the Screen Filler can be washed off without removing the photo stencil, you
can unblock parts, and use the underlying photo-stencil again later.

proofing ahead

With most other forms of printmaking, such as etching or intaglio, printing one layer of ink onto
one sheet of paper is a very laborious process. With silk screen printing, the opposite is true: once a
stencil is made and a color mixed, the time of actually physically printing one layer onto one piece of
paper is about half a minute, depending on how far you have to walk to the racks.

Therefore, | wonder if it is from other printmaking processes that some silk screen instruction
books have imported the notion that one must proof through all colors of an edition before
endeavoring to start printing the good ones. To me, it always seems so easy to just add one more layer.
Still, if you plan to have only 3 or 4 layers altogether, and you are printing a long run and/or using
expensive paper, proofing the whole thing ahead makes good sense.

Also, if you have the time and care a lot about how your colors will relate to each other, proofing
ahead just a few stencils on a many-layered print can be very worthwhile. It may help set you on the
right track, whether you are at the stage of still-blank paper, or much later in the process. Worthwhile,
that is, up to the point when you run out of screens and/or containers for mixed inks. And up to the
point when the proofs have helped you decide to alter the stencils or colors so much that you really
need to make and see those changes before further proofing can be much use.
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One reason for running proofs, at least of the color you are about to print, is that colors do change
somewhat as the ink dries. As a general rule, expect whatever color is under wet ink to show through
more after drying. Often the change is slight, but it can be dramatic if you are printing with very
transparent ink over a dark color. This is because our transparent “ink” appears to be a translucent
white until it dries. Look for a longer discussion in the”Color Mixing and Inks” section.

When | proof a color that seems particularly hard to judge while wet, | often try the new color
double-strength and/or half strength as well as whatever is my best guess. To see double-strength, |
print once, allow to dry two or three minutes and then print again. For half-strength, which | generally
try last, | add to the ink reservoir an equal amount of transparent base, and stir together with the
squeegee. If the ink reservoir has more ink than you'd need for a pass or two, then use the squeegee to
pull forward just part of the ink to mix with transparent base.

order of colors

Faint colors look much more vibrant against white paper than they will next to stronger, darker
colors, so, particularly if you will be printing a light color first, it is good to at least have some kind of
color sketch to guide you. Or, print or paint the strong color onto a test print before you make a final
decision on the faint color.

In my studio, beginning a complicated silkscreen that | can guess from experience might take 50 or
more colors to complete, | often print my first 6 or 7 colors, and sometimes even adjust those 7 stencils
and remix the inks and proof them again, before | begin to print onto my whole edition. That’s about
when | run out of screens and room for mixed ink.

| began this practice to try to cure a bad habit | had of printing many layers of nice soft colors in
good relation to each other, and suddenly realizing, way late, that the whole thing looked too faint and
blah. For that reason, | try to include one of the darkest colors, as well as one of the most vivid colors,
in those 6 or 7 stencils proofed first. It's useful for judging purposes, even if | might not print the strong
color on the whole edition until a little later in the process.

At class, you would rarely have a good enough reason to proof more than 2 or 3 colors before
printing. And what you gain in precision and control must be measured against what you lose in
excitement or surprise.

One good way of deciding what color to print (or at least proof) first is to pick the one that you
can picture best in your mind. Other times, if you are using transparent or translucent colors, the
desired combinations may determine your order.
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KNOW YOUR MATERIALS

ABOUT INKS:

Acrylic and fabric inks start to dry in your screen in a couple of minutes, and on the rack in 15 or
20 minutes (unless delayed by the printing of a large open area, high humidity, very absorbent paper or
fabric, or the addition of retarder thinner to the ink). By contrast, a bowlful of ink can be left out
uncovered for an hour or two without any appreciable drying or other harm. Almost any leftover ink
can be reused. There is a great range in the acceptable viscosity of printing ink, with a honey-like
consistency probably being ideal. Stir in a little water if ink has become too stiff, especially if you have
been flooding the screen, which causes the ink to evaporate.

When finished with a jar of ink, wipe the edge if you got ink on it. Since sometimes people don’t, in
class | request that you tighten the lid enough to safely pick up the jar by the lid, but not all the way
tight or it’s liable to get stuck. (Ink doesn’t evaporate fast enough to need a truly air-tight seal.)

If a quart jar does get good and stuck, my personal technique is to first bang it a few times, in an
upright position, against the cinder-block wall (not dry-wall or plaster!). Then, | put on rubber gloves,
and open the jar with both hands while | hold it tightly between my knees. The knee pressure squeezes
the plastic jar enough to add a little air pressure to my efforts. People with stronger wrists will have less
trouble. Soaking the jar in hot water usually also works. Again, keeping the jar edge clean is the best
practice.

Saving mixed inks: When adding to (and thus changing) a similar color already in a mixed-ink
container, please stir it up well, to make one even color. If feasible, also wipe your finger across the top
of the container with a little ink, to show the color inside.

In class, if you mix a color of ink that you want to save for yourself, just tape masking tape across
the top of the container and write your name on it. It will stay in a box under the table for your use.

ABOUT STENCIL MATERIALS:

Photo emulsion needs to be kept dark. If another screen is likely to be coated in the next hour or
so, you can leave emulsion in the scoop coater, if you follow this procedure: Use a square-ended
scraper to scrape down the emulsion on the scooper blade, so it is all at the level of the reservoir. Next,
clean the blade edge carefully with a damp but squeezed-out paper towel. Finally, cover the scoop
coater tightly with a double layer of tin foil. Otherwise, return the emulsion to its jar and, wearing
gloves, thoroughly wash the scoop coater.

You can coat the screen with emulsion in normal light if you're quick about it. Stop filling in edges
or smoothing it out if it starts to get tacky. Dim light is even safer, if you prefer.

Screen Filler block-out begins to dry very quickly on your brush or screen. Therefore, wrap your
brush in a damp paper towel when not immediately using, and clean any block-out mistakes off the
screen right away. On the other hand, it needs to be very dry indeed before you begin to print or to
remove Drawing Fluid resist. A hair dryer will not only hasten drying but also harden the screen filler,
making it less likely to dissolve.

Screen Filler tends to separate, and needs to be thoroughly stirred before use. When it needs
stirring, you'll see a little clear liquid at the top. If, when stirred, it’s too thick to brush easily, you may
add water, and stir again. If the Screen Filler in your little cup is too thin when stirred, mix it into a
thicker batch or return to the quart jar. If the whole jar is too thin, let it separate again, and pour some
of the clear liquid into a small container and save it. When the Screen Filler gets older, sometimes it
gets thicker, so you may want to add the clear liquid back in later. Adding a little water is OK too.
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Drawing Fluid dries quite slowly, and is so totally water-soluble that there is no rush in repairing
errors, and no danger of messing up brushes.

Both at home and in class, | have found Drawing Fluid prone to mold, and to thickening so much
that it becomes a stiff gel. | complained about this to Bud Martin, the nice chemist/PR guy at
Speedball, and he said he had not encountered or heard of this problem, but he’d look into it. The next
spring (2014), he told me he’d been trying all year to replicate my mold problem without success. So, |
mailed him a particularly moldy, gelatinous sample from class, its sad state not due to any effort on our
part to MAKE it mold. He later wrote, “I was finally able to get the Drawing Fluid to create some mold.
We had to heat it for 3 nights @ 135 F, then leave it open for 72 days while stirring it with a dirty
paintbrush every few days. We have started lab work on this. I'll send you some product when | have it
completed.” He did, but it still molds sometimes, and always seems to get too thick.

So we deal with Drawing Fluid as best we can. When it gets too thick to brush fluidly, | add water
to that small cup I'm using, and after that don’t stir up what'’s in the original jar. The liquid at the top
of the jar works just fine with no mixing. A little goes a long way, so I'm willing to forgo using the
bottom half of the jar. This is with an 8-ounce jar, which lasts at least as long as a quart of Screen Filler,
for the average user.

All three stencil materials can so securely glue their lids onto their jars that, even after wiping the
rims clean, | use a double layer of thin plastic bag between lid and jar to keep them separable. Or, with
the drawing fluid, just hold under hot water a minute if it gets stuck.

ABOUT CLEANERS:

Since | switched to water-based materials in 1987, there has been quite a convoluted history of
what works best for cleaning Screen Filler out of the screen. | can’t help but guess that “LA’s Totally
Awesome Orange All Purpose Degreaser & Spot Remover” will not be the last recommendation | ever
make, but it’s the best | can find as of 2019. | buy it at Family Dollar or Dollar Tree. The best cleaner
ever was Greased Lightning, but around 2007 they changed the formulation and it suddenly did not
work at all. | went back to Simple Green, which I'd discovered back in 1992, when Wisk, our favorite at
the time, suddenly changed ITS formulation so as to be 100% ineffective on Screen Filler. (One poor
middle-school art teacher, who | had helped with a silkscreen project, called to say she’d followed my
instructions with Wisk, and “we scrubbed one screen for two hours, and finally the fabric came off the
screen, but the Screen Filler never came off the fabric!”)

Speedball addressed the problem by developing a cleaner of its own, Speed Clean, but | find that,
like Simple Green, it requires more soaking than does Awesome Orange. Speedball has also offered the
good suggestion of an old-school solution, Arm & Hammer’s Washing Soda. It seems to work just
about as well as Awesome Orange, if mixed double-strength: %2 cup/quart of water.

Meanwhile, Greased Lightning has branched out with some variations, and at least one of them,
called “Super Strength”, is now somewhat effective, though still less so than the Washing Soda or
Awesome Orange. Awesome comes in a more concentrated version, which is yellow, not orange, but |
find it's more irritating to breathe without really being more effective. Even the regular Awesome
Orange can make you cough if you spritz it, so | trade out the spritzer for a pouring-type lid.

Note: If you have a photo-stencil with some parts temporarily blocked by screen filler, and you wish to
remove only those parts and leave all the photo emulsion, you must be very careful: If there is any
photo emulsion remover on the scrub brush, or on the wooden boards that hold screens up from the
table, it can dissolve your photo emulsion. Therefore, we have one scrub brush designated for ONLY
Screen Filler. You must also position the boards so they touch only your frame, not the fabric.

WATER-BASED SILK SCREEN PRINTING HANDBOOK click to go to table of contents 29



EQUIPMENT AND SUPPLIES
SCREENS

screen printing fabric

Back when | was printing with oil-base inks (1971-1987), | used real silk mesh. Dacron polyester
mesh existed, but it gave me some trouble with static electricity. Once | switched to water-base inks,
that problem was eliminated. Furthermore, silk turns out be dimensionally unstable when continually
wetted and dried, so Dacron fabric became the best choice. Dacron is also stronger; less prone to
develop the small holes that commonly appeared in silk fabric.

Polyester comes in two types of weave: mono-filament and multi-filament. Multi-filament imitates
silk, with lots of tiny strands making up each thread.

Mono-filament threads are each just one strand. This gives mono-filament mesh an advantage
when it’s time to clean up, because a single-filament strand of thread can’t trap ink inside itself, the
way a multi-filament strand can. Therefore, it is practical to use a much finer weave, for a higher mesh-
count, with mono-filament than with multi-filament, without it being any harder to keep clean. That
enables printing of very fine detail.

mesh-count

With mono-filament fabrics, the mesh count equals threads per inch. Above a mesh-count of 200,
fabric is dyed yellow or orange, because with threads so close together, light bounces around too much
on white threads during exposure of some photo-screens.

For fine-art printing on paper, a good mesh count is about 230, which is capable of very fine detail,
yet allows sufficient ink through to minimize drying-in problems, and is fairly easy to clean, as an even
finer mesh might not be. 195 is also excellent, except for the most delicate half-tones, small text, or
other tiny detail. Different brands have slightly different mesh counts available.

195 mesh works better than 230 on fabric, because a courser mesh always allows through more ink,
and fabric absorbs a lot of ink. A stencil that can be printed in one pass on some papers might need a
floodcoat in addition to two or three passes on a highly absorbent fabric. For printing light colors onto
dark fabric, or for any use of Speedball’s Opaque fabric series, an even coarser mesh is best. We have a
communal screen that is 137 mesh, which works well.

Multi-filament mesh is numbered differently, following the old designations for silk. | have used
14xx and 16xx with success. 18xx is too hard to clean. 12xx is coarse enough that thin liquid stencils
can occasionally have trouble spanning the distance from thread to thread. But 12xx is what you'll
generally find on Speedball’s small screens such as they sell with their various screen printing kits.

size

Choose a screen size according to your space and the size you want to print, but there are several
reasons why the proper screen size is larger than you might guess.

You will always need space for your squeegee to rest. | recommend allowing a good 3 - 4 inches of
blocked area between the image and your end of the screen. You can shorten that a little, but not
much, if you choose to rest your squeegee at the hinge end. You also want a couple of inches between
the image and the sides of the frame. If you put pressure on the squeegee too close to the frame, you
are liable to stress the screen fabric and/or pull away some of the adhesive that sticks the fabric to the
frame. It is also hard to get good contact once you get near the hinges, which intentionally hold the
screen 1/8” or more off of your printing surface. For the 20 x 28” inside dimensions of the screens we
use in class, a comfortable maximum size for your image is 15 x 22.”
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Victory Factory is our favorite screen supplier. You can order as many or as few screens as you
want, in a wide variety of sizes and mesh counts, at a reasonable price. Under most circumstances, it no
longer makes much sense to stretch your own screens.

frames

Back when | built my own screens, the frames were wood. When the silk eventually wore out, |
could just restretch the screens by stapling on new fabric. But with factory-glued screens, the fabric is
stretched so tight that it has a tendency to warp the wood. Eventually, Victory Factory stopped selling
wood screens altogether, but by then, they had reduced the prices on their aluminum screens so much
that they were hardly more expensive than wood, and so aluminum is what we now use in class.

preparation

| like to paint an inch-wide border of water-base polyurethane on the fabric just inside the frame,
so that the last little bit of mesh won’t need to be masked out some other way. Some printers tape the
edge of the fabric to the frame, which is definitely a good idea if your fabric ever starts to pull away
from the frame; use water-proof tape.

It has been the recommendation to wash a new screen with some kind of cleaner before using it
the first time, but with a cut stencil it doesn’t seem necessary. A liquid stencil, particularly photo
emulsion, may bead up and not coat well if the screen has not been washed, if there is any kind of
sizing on the fabric.But we don’t have any such problem with the Victory Factory screens. If photo
emulsion does bead up, rinse it off and then clean the screen with Simple Green or Awesome Orange..

PAPER

printmakers love paper

Freshman year at RISD, a drawing teacher took us across the street one day to “Oakes on the Hill,”
a charming little art store where we all bought supplies. After learning some things about different
materials, we were allowed into the mythical back room, where we stared in awe at shelf after shelf of
100% rag drawing and printmaking paper, sold by the single sheet, at prices that were beyond reach.
These papers came in various weights and sizes. The largest size had a particularly exotic name,
“Double Elephant.”

(The same teacher once told us, “A piece of white paper is a beautiful thing. If you can’t make it
more beautiful, leave it alone.” I've taken his words to heart, which sets me at odds with some strains of
contemporary art theory.)

size and weight

The thickness or weight of most machine-manufactured paper is measured in “pounds per ream”
for the “standard size” of that particular paper. That is, the standard manufacturing size, not necessarily
the size at which it is sold in a store. So, for example, 20# bond paper weighs 20 pounds in a ream of 17
x 22" paper, the way it's manufactured, though it may be later quartered and sold as 8% x 11”. As for
the term “ream,” it normally means 500 sheets, yet with some art papers, a ream is 1000 sheets. Few
countries besides the US still put up with such a confusing system.

The new standard for most of the world is “grammage”: the measure of grams per square meter,
for a single sheet. Most good art papers are measured in this way (or sometimes both ways). “Grams
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per square meter” is variously abbreviated as g/m’, gms, gsm or gr. The good news is, they all start

“«_n

with “g” and all mean the same thing.

papers for silk screen printing

For water-based screen-printing, to avoid rumpling, your paper should be a minimum of 250gsm,
preferably closer to 300gsm. You might get away with the printmaker’s beloved Rives BFK, with a
standard weight of 240gsm, if you don’t print large open areas. When | use BFK these days, | use their
heavier-weight 280gsm. If you are only printing very small areas, such as text on an invitation, rumpling
won't be likely, so you have more choice of papers.

Another exception to the heavy-weight rule is rice paper, which can print quite nicely without
rumples. There are many types of rice paper, so you may want to experiment.

White paper will show the colors you mix most accurately and vividly, but it can be fun to print
light-on-dark, or start with a cream or gray paper if you'd want a tinted background anyway.

Posterboard like we use in class varies some in weight, but mostly it’s thick enough not to rumple.
For archival fine art printing, don’t use posterboard, since there the issue is longevity, and the key is to
avoid acid, which causes paper to deteriorate over time. Then, look for acid-free paper and/or 100%
cotton rag. White posterboard does last a whole lot longer than newsprint: in my drawers are some 25-
year old prints on posterboard that look about the same as ever. For some reason colored
posterboards, and maybe even some white ones, have a grey cardboard core, which is no good, but
most white posterboard is white clear through. At about 50 cents per 22 x 28” sheet, at least at the
Dollar Store, it’s very affordable, though its lack of absorbency makes the ink bubble more than it
should, especially on the glossier side.

Bristol Board is much better. It’s a 2-ply acid-free paper, made by a number of paper companies,
and usually sold by the 20-sheet pad. The pad will probably say 100 Ib or 120 Ib., which for some
reason are both said to be the equivalent of about 260 gsm. “Smooth” prints well; “vellum” does too,
showing a little more tooth. Bristol is a reasonably priced, machine-made paper, with a pad of 20
sheets of 11 x 14” costing around $7, about 3 sheets/dollar.

Stonehenge is 100% rag, machine-made in America. It is most often 250gsm and sold by the 22 x
30" sheet. It has a nice smooth surface for printing on, and is one of the least expensive rag papers,
available at $2-3 per sheet.

Arches 88 Silkscreen was developed specifically for water-based silkscreening, to have the least
possible amount of rumple. It is 100% rag, mould-made in France, and a nice heavy 300gsm. It has an
extremely smooth, hard, bright white finish, with no sizing at all, which means a drop of water can puff
it up, never to flatten. It also doesn’t take kindly to drawing, or especially erasing. (When | started using
Arches 88, | switched to making my master drawing on frosted Mylar, which is wonderful to draw on,
including erasing). Arches 88 is lovely to print on, and expensive, now costing $5-7 per 22x30” sheet.

A little history: Arches and Rives merged in the 1950s, after centuries of manufacturing ups and
downs you can read about online. Arches still produces its paper at the original mill, founded in 1492
in Lorraine, France. A number of grain mills were being converted to paper mills at that time, as Europe
was introduced to the skill of paper-making. Frenchman Jean Montgolfier had been captured by Turks
during the Crusades, and sentenced to work at a paper mill in Damascus, where he learned how to do
it. The Islamic world had discovered paper-making a few centuries before, from Chinese prisoners of an
earlier war. Legend has it that the very first human paper-making was in 105 AD, by Chinese nobleman
Cai Lun, after close observation of wasps.

Rives BFK Heavyweight, 280gsm, is sturdier then Arches 88, and can be drawn on, erased, and
subjected to water without fear. (Etchers dampen it before running it through the press.) BFK is
mould-made of 100% rag. It has a little bit of tooth, which will show up as a slight texture when you
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print a large area with a transparent color. BFK is the traditional printmaker’s favorite, most commonly
sold in 22x30” sheets, and runs around $5 a sheet.

Other papers | have used with some success include Pescia, Somerset, Arches Cover, and Arches
hot-press watercolor paper. Some printers like Lenox, but | find it subject to cupping, a word | hope |
didn’t make up to describe a slight curling up of all edges, making 3-point registration difficult.

Most of the 100% rag papers are mould-made, and most are also made in a larger size as well as the
22x30. A characteristic of mould-made papers is a deckle edge on 2 or 4 sides. The unevenness of
deckle edges is appealing, but makes 3-point registration tricky. Please see my suggestions in the
“Registration” section.

Handling paper

When handling individual sheets of large size paper, such as 22x30 or larger, it is imperative to
avoid “cockles” or “dimples”: little tiny dents in the paper where it decides to sharply bend instead of
harmlessly curve. When I’'m holding large paper in a horizontal position, for moving it from under the
screen and for setting it onto horizontal racks like | have at home, | carry it in both hands, with my
fingers spread out under the paper to support it and my thumbs lightly holding it from the top. In my
imagination, the air is helping hold it up, and it makes me feel a little bit like a pizza-maker somehow.

Unfortunately, individual sheets of paper in the drawers at Blick in DC are full of cockles;
customers handle it without knowing how to. Either at the store or if ordering online, order in bulk if
you possibly can. 25-sheet packs are often wrapped at the factory or warehouse, before they can get
hurt. 100-sheet boxes are safest of all. Ordering 100 or 25 or even sometimes just 10 sheets can often
get you a discounted price as well. Talas, in Brooklyn, is one source of paper | have used recently.

For many years, printmakers around DC had a wonderful paper dealer to rely on, Guy Kuhn. He
charged low prices, and offered free delivery from his warehouse in Hagerstown. The paper and
matboard always arrived in impeccable condition, and in retrospect | wished he’d charged a little
more, instead of losing money and having to go work at WalMart.

One more hint: for precise registration, acclimate any large paper to the humidity of the room
before you start to print a multi-layer silkscreen. Spread it out on racks for at least an hour, if not
overnight.

SQUEEGEES

dull vs. sharp blades

| hardly ever buy squeegees, because they last so long. The edges of the blades do wear down, but
that’s fine with me; | often prefer the slightly soft-edged look that results from printing with a dull
squeegee, which sends more ink through the screen than a sharp one does. When you use a cut-out
stencil, it's hard for a squeegee to get good contact with the paper due to the thickness of the stencil,
and it helps to use a dull squeegee and also give it two passes or else a floodcoat (“flood” the mesh of
the raised screen with ink before printing). For printing onto paper using a block-out or emulsion
stencil, | most often find a single pass to be sufficient, especially when it’s not the first layer on bare
paper.

Maybe I'm just lazy, but when some screenprinting manual states that | MUST continually sand
down my squeegees, and MUST use a flood stroke when | print, my response is, Hey wait a minute. If |
just DON'T sand the squeegee and DON'T flood the screen, | can get about the same results with a lot
less trouble.
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In fact, the time I'm likeliest to put sandpaper to a neoprene squeegee is when | first buy it, and
want to round down the edges a little. The other time | sand the blade is if there’s a nick in the edge,
which leaves a little ridge of ink on the screen, showing as a darker line if you print with a transparent
color.

For a sharp-edged image or for really fine detail, yes, it is important to use a sharp squeegee. Then, |
recommend the other type of blade, made of urethane. The best ones I've tried are the “high
quality”(#3551) translucent amber blades at Renaissance Graphic Arts (www.printmaking-
materials.com), but Victory Factory’s are fine too, and cheaper.

Urethane squeegee blades last even longer than neoprene, if you do a lot of printing, so they are
the standard for commercial screen printing. They also keep their sharp edge, which is good, because |
don’t find them easy to sand down. When they do deteriorate, they start to sluff off little crumbs,
ruining the edge that way. Or sometimes they just crack up, and big chunks fall off, sometimes a little
gooey and sometimes hard as a rock. It is possible that previous use of solvent-based inks is the culprit
in my encounters with these issues, on squeegees that have been donated to the Art League.

flexible vs. stiff blades

Squeegee blades are also rated by stiffness, measured in durometers. 50 durometers is the most
flexible, 85 the stiffest. 60 - 70 durometers is a good all-purpose blade. To gauge the relative stiffness of
a squeegee, see how much give the blade has when you try to bend the corner of it between your
thumb and finger. Both types of blades seem to stiffen over time.

Flexible blades send through slightly more ink. More importantly, they take less pressure to pull,
and are much more forgiving if your work surface is a little uneven or out of plane. The larger the area
you are printing, the harder it is to get good contact all across it, and the more you will appreciate a
flexible squeegee. Other times, a very flexible squeegee might feel too squishy.

Stiff, sharp squeegees are the least likely to send any ink beyond the exact outlines of your stencil.
They are also the quickest to dry out the ink in your screen, especially in those same finely detailed
areas they print so clearly. The sharper the squeegee, the more likely you will want to flood your
screen, as is true anytime your ink starts to dry in the mesh. If trouble persists, you also may wish to
add a little retarder base to the ink, and/or mist the screen with water (at one end or the other; don’t
spray the open area). And/or periodically scrape the ink from the screen and mix back into the bowl,
adding a spoonful or two of water.

squeegee handles

| recommend classic wooden handles, which are curvy to make them easy to hold. Square wood
handles are horrible for hand pulling. Probably they are meant for “one-armed squeegee” machines.
Because of arthritis in my wrists and at the base of my thumbs, | have tried several different types of
squeegee handles claiming to be even more ergonomic than the curvy ones, and every single one has
been worse instead. People’s hands are different, so perhaps the innovative ones are a help for some.

Squeegees can be bought either already put together, or as separate lengths of blade and handle.
Some are bolted together, drilled right through the blade. The bolts are reusable if you get a new blade.
Other squeegee blades are permanently stapled to the handles. Squeegees can also be just set in the
handle without fasteners, which allows the possibility of switching to the sharper, duller or unnicked
edge, without moving the nail (or screw) that | like to put in the middle of the squeegee handle (to let
the squeegee rest on the raised end of the screen). If the blade is not fastened on, it’s a good idea to
paint polyurethane onto the inside of the handle, where the blade goes, to keep the wood from
splaying out when it gets wet. Another idea, that | never remember to try, is to tape the squeegee
where the blade meets the handle, which will keep ink from seeping up into that seam.
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squeegee length

Ideally, a squeegee will extend an inch or two into the blocked area on each side of your image. If a
squeegee is too short, it will require needlessly precise aim, in order to print both edges of the image, or
else it won't even print the whole image. Then you'll be left with a ridge of thick ink at the edge of the
squeegee blade, whether or not you make a 2" pass that overlaps the first. This ridge will appear as a
darker line, if there is any transparency to the ink.

On the other hand, a too-long squeegee makes its own trouble: it will kind of bump and scrape
along due to friction, if the edges of the squeegee are dry instead of riding along on ink. Laying out ink
along the full the length of the squeegee will help, but since none of that ink goes through the screen,
it will start drying out and again be less slippery. Furthermore, if it’s a stiff squeegee and there’s any
unevenness to the table, you may have unnecessary problems resulting from bad contact between the
squeegee and the paper.

which to buy

The perfect squeegee, of just the right size, flexibility and sharpness for your purposes, may not be
available in class at any given moment. So compromise. In your own studio, you can’t have every
possible option available, either. Start with a general notion of what scale images you are most
interested in printing. Get a long, flexible squeegee that is just 4 or 5 inches shorter than the inside
measurement of the shorter side of your frame, if the screen is similar in size to the ones at class
(23x31" outside dimensions.) Then buy at least one smaller squeegee, 6 or 8 inch, perhaps with a less
flexible blade.

squeegee care

It is vital to keep the squeegee blade free from nicks. As mentioned above, a nick on the printing
edge will give you a line of thicker ink, the length of the squeegee pass. If the ink is transparent at all,
that results in a long darker stripe. Sandpaper, especially a length of sandpaper glued to a board, works
to smooth out a nick, or sand down the whole bottom of the blade if you want to sharpen it, or get rid
of any rough edges.

Overall, squeegees are pretty hardy. Make sure to clean all the ink off the blade, but then it seems
to do no harm to just shake off the excess water and put the squeegee back in a pile. Of course, it is
easier to find the one you want if you arrange them in some way. On the squeegee cart at class, we
have sometimes sorted them by size and set them with the blades pointing up, so you can see what
blade type is available in a suitable size. In a home studio, if you have the space, hang some or all of
them on nails, using a screw eye or 1/4” drilled hole at one end of the handle. At class, if you pick a
squeegee that might have been recently used, make sure it’s dry.

KICK-STICKS AND ROLLING LEGS

kick-sticks

When | first took silkscreen class with Art Wood at RISD, back in 1971, he taught us how to put
together a wooden frame and stretch it with silk. After we stapled it, taped it and shellacked it (this
was in the days of oil-based inks), he showed us how to make a kick-stick, to prop it up while printing.
It should hold the screen at a 30 degree angle, give or take, and | only know how to make one for a
wooden frame.

You need a hammer, nail, drill, and a 6 or 8" length of lattice, which is an easily-found rectangular
wood molding about 3/16" by 1%". The nail should be about 1 1/4 -1 %" long, with a big head. A sheet-
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rock or roofing nail works, but if the edge of the head is sharp, pad it with masking tape after it’s
attached. An inch from one end of the stick, drill a hole a little larger than the diameter of the nail,
centered between the sides of the stick.

Setting the screen up on edge, position the stick along one side of the frame, with the end you
drilled almost at the front corner but not quite, and centered from side to side; you don’t ever want
the kick-stick to keep the screen from sitting flat. Drive in the nail, stopping when the head is about %”
from the frame. The hole in the lattice should be large enough that the kick-stick swings freely. If it
seems wobbly, hammer in the nail a little further.

When you lift a clamped screen, the kick-stick will automatically swing down and hold up the
screen. When you're ready to lower it, just slightly take the weight off the screen with one hand, and
flick the base of the kick-stick toward yourself with the other, as you lower the screen.

rolling legs

After | had been printing a few years, | decided to try making some silkscreens as large as | could.
The limitation is basically how far you can reach, if you don’t want to go to machine-printing, which |
didn’t. With a big enough printing table, that arm’s length can be the short side of the screen, if you're
willing to pull the squeegee sideways. It’s a real awkward movement and | don’t recommend doing
much of it. (1 did a lot of it, and | suspect that move of triggering the first area of arthritis in my right
hand, which was in an unusual joint.)

A screen that size (about 32 x 38") is awfully heavy to raise and lower, so | switched from a kick-
stick to a rolling leg, aka a Jiffy Side-Kick, which attaches to the screen by little screws or (for aluminum
frames) a clamp. With a small wheel and an adjustable spring, it does some of the work of raising and
lowering the screen.

plywood box from hell

When | began to teach at the Art League, in 1997, | thought it was awfully primitive that the
students were using blocks of wood to hold up their screens. | made a kick-stick for every screen, only
to discover that the screens would then not fit into the home-made plywood box that we had to use
for power-washing.

This box infuriated me in every way. It was designed and built by a very tall person, for a very tall
person. Everybody else had to stand on a stool to reach it. The box was attached to the wall, over a row
of five sinks in the hallway just outside the ceramics room. The ceramics room has a partition, not a
wall, separating it from the hallway, affording almost no sound insulation. My first year, there were no
sinks of any kind in the silkscreen classroom, so we were required to do all of our screen clean-up,
including ink wash-out, in this one plywood box. You put the screen in through the front door, which
had warped and didn’t quite shut. In the door was a Plexiglas window, with a hole in it, so the nozzle of
the power washer could poke through while we watched and guided it, except that the window got all
steamed up and ink-splattered, so we couldn’t see well enough to guide it much. Because the door
didn’t shut tight, it would occasionally pull open by mistake, and splash dirty water around.

The VERY LOUD power washer reverberated throughout the building, but especially in the
ceramics room eight feet away. Making matters worse, from the ceramicists point of view, is the fact
that they were used to having all five sinks to themselves. One sink was always filled up with water for
soaking (slaking?) clay. Now, with the invasion of the silkscreen class, the sink under the power washer
was completely out of commission, and the two to either side of it were awkward to use and rather
dangerous, with sharp corners of the box near eye level at the adjacent sinks. The sinks were also the
only place we had for washing out our bowls, spoons, and squeegees. Most people just don’t realize
how much dish-washing is involved in water-based screenprinting.
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The first night | ever visited the class, after Geri Gordon asked me if I'd like to teach it, | entered the
building and heard what | thought was somebody operating a loud power drill. Way down the hall,
around three bends, | discovered the noise to be coming from the screenprinting pressure washer. This
machine happened to be broken at the time, emitting such a narrow stream of water that it took ten
times as long as it should have to clean a screen. It was also leaking water all over the floor, so | spent a
good bit of that evening with a mop in my hand. I'd never used a power washer at home, and wasn’t
sure | ever wanted to at class, either. Certainly not that one.

While the school ordered a new power washer, | hooked up a short garden hose and nozzle to the
unused faucet under the plywood box, setting screens upright in the adjoining sinks to wash out ink
and remove block-out stencils. Photo stencils, unfortunately, could not be removed completely
without the power washer. (I had never used the photo process at home, but had to learn to, in order
to teach it, since it’s the most popular kind of stencil by far.)

redesign at the Art League

At that time, the Madison Annex was a newly acquired classroom space for the Art League. Before,
screen printing had been taught only sporadically, in a completely unsuitable, tiny sinkless room at the
Torpedo Factory. Space constraints did inspire the teacher there to invent the marvelous drying racks
that we use to this day; two rows of hanging racks that can be raised to the ceiling with clothesline on
a pulley system.

Besides installing those drying racks, the school had already built us a big set of permanent vertical
shelves for storing all our silkscreen frames, and plywood table-tops with hinge clamps for printing on.
In the darkroom, they had rigged up a set of three Halogen work-lights attached to a bracket, for
exposing our photoscreens. This device could be folded up out of the way of the photography
students, except that it had a habit of falling down. | don’t even remember how we kept the other
emulsion-coated screens in the dark, if we were using the darkroom for exposure. Also, those three
500-watt halogen bulbs would blow the fuse, any time we accidentally plugged a hair dryer into the
same circuit.

Luckily, I had just started teaching when the school received a big donation to improve the
darkroom and the whole photography set-up. Since silkscreen used the same room, and the darkroom
too, | got some input as they were figuring out how to revamp the space. The silkscreen room got a
bank of three laundry sinks, just the right size to fit our screens on the diagonal, and a big water heater
of our own to go with it. The electricity was heavied up and the exposure lights got their own circuit in
the new bathroom (which amused me: silkscreen instruction books always claimed you could set up
photo lights in the bathroom, and sure enough!) That left the darkroom free to keep the coated
screens dark while the emulsion dried.

How to fix the power washer situation remained a puzzle. Mark Hatfield, the head of the ceramics
department at the time and also a farmer, suggested we could try using a sheep trough, which might
fit next to the hallway sinks instead of above them. He did allow as we’d need some way to make it
drain. | visited a couple of art schools, and there the power washer was always in its own separate
room, sometimes with a light behind it to help show if the emulsion is completely removed. (Nice
touch!) The ceramics associates voted for us to put the power washer in our own room, hooked up to
our own sink. The sentiment was understandable, but the suggestion was unacceptable. It’s already too
loud, just spraying ink off our screens with the garden hose in our room, because factory-stretched
screens are tight as a drum, and water bounces off them quite resoundingly.
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In the end, our new building manager, Jim Nemer, retired Navy guy, very handy and creative, built
us a contraption in the janitor’s closet: a hinged, 4-cornered shower rod, built out of 3/4” copper pipe,
that clips to the wall when not in use, and folds down to horizontal, over the floor-level mop sink. |
customized two clear vinyl shower curtains, and we were all set. The device does have something of a
make-shift appearance, a little crowded by the mop buckets. But at least the closet has a ceiling, so
closing the door does some good, noise-wise. | used to have visions of a terrible mishap in which
something went haywire and we ruined the school’s whole supply of toilet paper, which is stored in
that closet, but actually there have been no disasters. Jim Nemer also attached a boat cleat to the wall
near the drying racks, so we could stop using the electrical conduit to secure our pulley line.

blocks of wood

As for those kick-sticks I'd added onto the screens at class, | pulled them all back off. By the time
we got a better set-up for the power washer, | had discovered the virtues of the blocks-of-wood
system, which | now use in my studio, too.

Many students work small enough that a 23 x 31” screen can fit one stencil on each end. The hinge
clamps on our tables, which are designed for off-contact printing, and therefore hold the hinge end of
the screen a good 1/8” off the table, make it very hard to get good squeegee contact at the hinge end
of the screen.

It’s also easier to register near the raised end of the screen rather than reach half-way to the hinges.
So for a screen with a stencil at each end, | recommend rotating the screen when you print the second
stencil. And although a kick-stick doesn’t really do any harm at the hinge end, it certainly won’t hold
up the screen.

A block of wood , once you get used to it, really isn’t much harder to use than a kick-stick, unless
you are printing with a flood-coat. Some flooding techniques might make you wish for a third hand,
unless you have a kick-stick or rolling leg.

The subject of off-contact printing is a whole other rant, which | am postponing until page 53,
when | discuss lift-marks in detail.
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MY TWO BEST TIPS

Here are the words of advice | find myself speaking most often as | teach silk screen printing: “Hold it
up to the light,” and “Get it from both sides at once.”

“HOLD IT UP TO THE LIGHT”

What does that mean, exactly?

It means, get the screen in a position that’s directly between you and a strong source of light. In
our classroom, that requires holding it so you can see the florescent lights straight through the screen
mesh. If you have a studio with a window, you won’t have to crane your neck so much.

The point is to see where the light can shine through any given part of the mesh and where it can’t.
Generally, if light can pass straight through, so can ink. Until you hold it to the light, it can be hard to
tell a harmless ink stain apart from a screen-blocking bit of old stencil or dried ink, or if there are any
pin-holes or other gaps where the ink may leak through an area meant to be blocked.

When is it useful?

When choosing a screen to put a new stencil on: If there are just a few screen-blocking specks
(and/or small holes) in the screen, you may be able to work around them. Circle with pencil or pen so
you won't lose them, and avoid specks in open areas of your stencil. Small holes in the fabric are OK in
open areas, or in blocked areas far enough from the image to block with tape or contact paper on the
underside of the screen. Or, a speck may come out with acetone, Awesome Orange or Emulsion
Remover, wetting two small squares of Kleenex, rubbing from both sides of the screen at once. If there
are lots of specks, the screen needs powerwashing; don’t use it.

After putting on resist, before coating a screen with block-out: To see if the resist is blocking
the mesh well enough to resist the block-out. If not, touch up.

Before printing, with any kind of stencil: To see if the stencil is completely filling the mesh
everywhere you want to block ink. If not, touch up with the red Screen Filler block-out, or block with
contact paper, or put tape on the underside of the screen if it's something narrow like a glass line. (A
glass line is when the edge of the glass somewhat blocks the light during exposure, so that it stays soft
enough to dissolve with water. The edges of transparency film sometimes do the same).

While washing off ink, right after printing: To make sure no ink is still actually lodged in the
screen. If it is, spray or wipe with Simple Green, and then rinse. Be cautious if it’s a red block-out stencil;
Simple Green will eventually dissolve it, whereas it doesn’t effect photo emulsion. Don’t worry about a
little ink if it’s just on the stencil; it will come out when you reclaim the screen. Simple Green also helps
fade ink stains, if they're fresh.

When you reclaim a screen by removing a stencil: To see if you have gotten the emulsion or
block-out off completely. It’s especially important to clean off all photo emulsion, because any left on
will be double-baked when you expose your next photo-screen, and could be stuck on permanently.
The red block-out will always remain removable, though later it may take a little more soaking and
scrubbing. In either case, if you have time, it’s easiest to finish the job once it’s started, with the stencil
softened up. Wipe the screen just so it’s not dripping, reapply cleaner, and spray again. Any stencil
material within 1 % or 2" of the frame can stay, since it’s best not to print that close to the egde
anyway. Try to avoid blasting off the polyurethane | applied just inside the frame.

You can judge a screen either when it’s wet or when it’s dry, but not when it’s half-dry: water in
half-dry mesh can appear to block it.
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“GET IT FROM BOTH SIDES AT ONCE”

What does that mean, exactly?

When you're trying to get something out of the screen, it very often helps to rub both sides of the
fabric at once, sometimes with damp rags, sometimes using Kleenex wet with cleaner. For a stubborn
spot, that intense focus on one little part of the mesh can be very effective. If it squeaks, you're doing
the right thing.

When is it useful?

When a trace of old stencil blocks an otherwise clean screen: Try either acetone or the
appropriate stencil remover, on a Kleenex or good paper towel (the brown ones are too linty). Wear
gloves, and, if acetone, make sure there is good ventilation. Fold a Kleenex into two small squares: fold
it in half 5 times, tearing it into two pieces after the 3" or 4™ fold. Place it tightly over the opening of
the bottle, as you tip the bottle to get acetone or stencil remover onto the Kleenex. Stencil solvents
must be rinsed out of that part of the screen afterwards; acetone does not.

When you want to remove a small part of a stencil: If you make a mistake as you are painting
with block-out, it will come out with water if you catch it right away. If it’s started to dry, you may
need alcohol or a tiny bit of Awesome Orange. In any case, rubbing from both sides makes the job
quicker and easier. With either a photo stencil or block-out stencil, when you want to remove a small
section while leaving nearby areas undisturbed, you can dilute the stencil cleaner with water, to give
yourself more control. Again, rinse after using stencil remover; no need after acetone or alcohol.

When taking out resist: Two damp rags remove it easily, one on each side of the fabric. Stand the
screen up on end, with the edge toward you. Rubbing both sides at once will help keep it balanced.
Don’t use hot water; it can take out too much of the Screen Filler.

While printing, if a speck of dried ink or unwanted stencil clogs the screen: You will most
often be able to keep right on printing if you just take a damp rag or Kleenex on the top, and a dry
paper towel (or Kleenex) on the bottom, and rub off the speck. If it's stubborn, you may need to get
both sides of the fabric wet, but then you might have to dry the bottom side of the screen before
resuming printing. If there continue to be problems with the same ink, it may need to be strained with
a paint strainer (a circle of wide-mesh fabric surrounded by elastic, available where house paints are
sold, and in class kept on the bottom shelf of the cupboard).

After washing out a stencil, if a few small areas remain: It may sometimes be easier to spot-
clean rather than spray out the whole screen again.
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COLOR MIXING AND INKS

basics of color mixing

There are two main aspects of color mixing for silkscreen. The first challenge is to get the shade
you want, so that it looks right when printed onto white paper. The second issue is how it will look
printed on top of any layers already on your image. For this second aspect, learning to control the
transparency or opaqueness of the ink is essential. Since the way | print is to layer up many transparent
colors, the notion of “color recipes” is foreign to me. But for someone who likes to work with primarily
opaque inks, in a particular palette that doesn’t correspond well with the limited number of colors
available from Speedball, it might be worth measuring spoonfuls of ink as you work your way to a
shade you like, and note down the proportions for future reference. In class, if you've mixed a color you
want to save for later use, you can just put it in a container with a piece of masking tape on top with
your name on it, and we’ll save it for you.

For general color mixing, if you don’t have an art background, | recommend that you use a color
wheel and a cheap set of watercolors to practice color-mixing. Or just take some dabs of the silkscreen
inks, and see how they mix with each other, particularly the Process Yellow, Cyan & Magenta, which
make the purest, most vivid colors, alone or mixed. From Yellow and Cyan, you can mix a green, and
anything in between. Cyan and Magenta make purple. Magenta and Yellow make orange, as well as a
red without the pinkness of Magenta.

To make a color less vivid, add gray or brown, or a complementary color. The complements are
yellow to purple, orange to blue, and red to green. Black will darken and white will lighten; both will
also tone down the vividness of your color.

coffee experiment

In considering transparency, try this, either as a thought experiment or for real:

Take three clear mugs or glasses, and fill two of them about half full of coffee (or strong tea). Now
imagine you'd like to lighten the brown color to beige. There are two ways to lighten any color: add
white, or add transparency. We can compare what happens to the coffee when we add milk vs. when
we add water.

Add milk or cream to one glass, and the color will lighten to beige fairly quickly, especially if you
use cream.

Add water to the 2nd glass. Fill it up. The color will not have lightened much.

Take the third glass, and fill it halfway with water. Try to have something white behind them, to
help you judge colors. Then add coffee from the 2™ glass to the 3" glass, just until you get the shade of
beige you are looking for. It won't take a lot.

Not surprisingly, you can see right through the beige made with water, but not the one made with
milk. You may also note a difference in the quality of the color. The opaque color will look grayer than
the transparent one. As this suggests, even on white paper it makes a little bit of difference whether
your color is transparent or opaque. And, it takes a lot of transparency to make a color fainter.

I'd thank an old American Artist magazine article for this concept. Unfortunately, | don’t recall the
issue or author, and possibly not the decade.

Transparent Base and Extender Base

With silkscreen inks as with coffee and tea, adding white will lighten a color, dull it some, and make
it more opaque. Adding Speedball’s Extender Base or Transparent Base (or a combination of the two)
will make a color both lighter and more transparent, but it takes REALLY A LOT of transparency to
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make a very faint color. So for a faint color, always start with a bowlful of transparent base (or however
much ink you think you need), and add just a small spoonful of color. Stir it, and then check it out by
wiping your finger on a test strip or scrap print, and add more color till you get what you want. If you
wish to hide underlying layers as much as possible, avoid transparent base and the Process colors, and
add white to your mix if feasible. If you want the top color to lighten the underneath color somewhat,
but not hide it, add partly white and partly transparency. If you don’t care either way, or if you are
printing only onto white paper, I'll mention that transparent base is quite a bit cheaper than white (or
any color) ink.

When | say “transparent base” these days, | mostly mean a combination of Speedball’s Transparent
Base and Extender Base. What's the difference between the two? Well, the big one for me is that
Transparent Base is clear when you print it, whereas the Extender Base is white, like EImer’s glue, until
it dries. This makes it very difficult to assess a transparent layer printed over a dark color: It might easily
lighten the underlying color when wet but darken it when dry.

Transparent Base is part of Speedball’s line of fabric inks, which is ironic, because it’s not very
water-resistant. Therefore, the label advises to use no more than 10 - 15% by volume, which isn’t
remotely enough to lighten a color. Now, all of the fabric inks can be printed on paper as well as fabric,
and can be intermixed with Acrylic inks. The main difference between the Fabric inks and the
Permanent Acrylic inks is that if you iron or otherwise heat-set the Fabric inks, they can go through a
washing machine. Since you will not be machine-washing works on paper, it's OK to use more than
15% Transparent Base, from that point of view. But in some ways the printing qualities of Transparent
Base are not as good as those of the Permanent Acrylic Extender Base; for instance the Transparent
Base is more prone to bubbling, as well as less water-resistant and in that sense less permanent. In class,
| split the difference and mix half and half. (At home | use 2/3 Extender Base.) Sometimes in class | call
the combination “transparent ink.”

what to avoid

But do not fall into this trap: do NOT buy the ideal-sounding “Speedball Transparent Extender
Base.” It is part of Speedball’s Water-Soluble line of inks. Do not think “Water-Soluble” means the same
thing as “Water-Based.” Oh no. Water-Soluble inks are designed for children. They wash out of clothes.
But they serve children badly, because they are difficult to print with; they tend to clog the screen. And
you are not supposed to mix them with Permanent Acrylic inks (unless you want to really clog the
screen), which Speedball used to warn you about on the label. Lately, the labels have gone three-
language, which eliminates a lot of the useful information they used to have, including that warning,

So I'll say it as loudly as possible: DON'T USE SPEEDBALL’'S WATER-SOLUBLE INKS. At least, the
three lines of Speedball inks aren’t all jumbled together, on the internet, like they used to be on the
shelf at the Pearl in Alexandria, back when one could actually buy screen printing supplies locally. (I
used to sometimes go in and leave little warning notices on the shelves or with the cashiers.)

retarder base

Speedball sells one other type of base, Retarder Base. | hardly ever use it, but probably | should
sometimes. If you have trouble with the ink drying in your screen, it's something to try. Add a spoonful
or two per cup of ink. Understand it will make it take longer for the ink to dry after printing. Since one
handy thing about silkscreen printing is how quickly you can stack your prints or add another color, |
usually suggest that if the ink seems too stiff, just add water. But there are some inks that dry in the
screen especially quickly: notoriously, the Opaque series of fabric inks. Also, fabric inks in general, and
metallic colors, even in Acrylic inks. Mixed ink that includes transparent base is least likely to clog the
screen. Drying out also depends on your screen mesh and stencil: the finer the mesh, and the finer the
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detail, the more quickly the ink will dry in the screen. Flooding will keep the screen wetter, but also dry
the ink out quicker. An alternative to retarder base is to just keep misting the screen with water (not in
the open area) and/or periodically put some of the ink on the screen back into the bowl with the rest
of your mixed ink, and stir in a little water.

how much ink to mix

How do you tell how much ink you will need in order to print? | have occasionally made some
measurements. A 16" squeegee takes about 1/4 cup of ink to flow properly (1/8 cup fora 6 - 8"
squeegee). Beyond that, another 1/8 cup (2 tablespoons) will be actually printed onto 10 sheets of
paper, if the open area of the screen is about 70 square inches (7" x 10"). Don’t figure your overall
image size, but just the area of the color you are mixing. We don’t use measuring cups in class, but if a
regular cereal-size bowl looks about half full, that’s about 3/4 cup.

It’s easy to guess wrong as you try to mix the color you want, especially since the strength or
transparency of the colors people save in our mixed-ink containers is quite variable, but | encourage
you to utilize these saved colors when you can, so we don’t become completely overrun with mixed
inks. Testing your color on something out of our scrap pile will help you get an idea how the color will
look on white paper as well as over dark colors. If you have mixed a good quantity of ink but the color’s
not right yet, please, take a second bowl. Put in just some of what's in the first bowl, and add what you
need to get the shade you want. Working in my studio, | have a tendency to overcorrect, and then am
glad to have what's left in the first bowl to add back in to the second. Also, because of our space
limitations at class, it’s best to mix plenty for what you need, but not a whole lot more.

what will it look like on the print?

How can you tell what a transparent ink will look like on top of colors you've already printed? Well,
to start, if you have a badly-printed copy of your image so far, you can smear a little of the new color
on with your finger. You can also avoid wasting one of your good prints if you find an old image in the
scrap pile with similar colors. Or, wipe a fingerful of the new color onto transparent film, and set that
over any one of your prints. Since it’s hard to gauge the thickness of a printed layer of ink, you can get
an even better indication by printing the new color onto acetate or copying film, using a small test
screen (or any screen you're not about to need). Use a squeegee smaller than the acetate. Dry the
printed film with a hair dryer if you want, and see what it looks like set on top of your print-in-
progress.

If you feel strongly about exactly how the color will look and relate to the rest of the image, |
recommend running a proof. That is to say, print your new color, once you like it, onto a good print
and let it dry before printing the rest. If you can clean your screen with two rags while it is still in its
hinges, and use the hair-dryer on your proof, this need not take very long. If you skip proofing, but the
color seems questionable once you start printing, use the hair dryer on at least a portion of the print,
meanwhile printing onto scrap paper every minute or two so that the ink doesn’t dry in the screen. If it
looks all right once it’s dry, just resume printing. If you need to remix the color, keep printing out on
scrap paper every minute or two, using transparent base instead of the old color if it needs lightening
anyway.

light-fastness of inks

The main measure of the permanence of inks is their light-fastness ratings. The ratings are similar
between Speedball’s Fabric and Acrylic lines of ink. They are generally in the good to excellent range,
but orange and magenta only rate a “fair.”
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In my experience, printing paper, even rag paper, yellows before the colors fade. Actually | haven’t
really ever seen the colors fade, even when | left them out in the bright sun for many days (some parts
shielded, for comparison), and even when | baked them in the oven once, to try to compare “good”
with “excellent” ratings. Speedball’s Fluorescent colors are rated “poor,” so | avoid them.

comparing brands

Since switching to water-based inks in the mid-1980s, | have not experimented much with other
brands. When | switched over, | had become extremely sensitized to the smells of any solvents, and
even some water-based inks had a strong smell, so | stuck with Speedball, which had long had a
reputation for safety-consciousness. Their reputation for quality was less impressive, probably because
they had up to that point been chiefly selling water-soluble inks; the Permanent Acrylic inks were a big
jump ahead. Also, | haven’t found another brand that has anything quite equivalent to Speedball’s
good Screen Filler block-out.

A whole other type of ink commonly used by T-shirt printers these days is Plastisol. It’s not water-
based but not very toxic either, because it contains virtually no solvent. This strange ink never dries
unless it’s heat-set, so a lot of printers don’t even keep the lids on the containers (though that’s an
invitation for lint and dust to mix into the ink). You need a piece of equipment called a flash dryer, to
briefly raise the temperature of the ink to 320 degrees, after printing. Because Plastisol has a very thick
consistency and doesn’t dry, you can even leave the ink on the screen for storage, although this would
have the same lint-and-dust issue. To clean the ink off the screen, it does take a toxic solvent, or it used
to, until Plastisol came out with the environmentally friendly “Citra Paste,” a citrus cleaner.

By all means, try other brands of water-based inks. I'm intrigued by Createx, which sells both
“Liquid Pure Pigment”, to mix into transparent base, and Acrylic Colors which say they can be either
painted or screenprinted. | have used regular acrylic tube colors, or better yet the more liquid
Concentrated Acrylic Color that comes in bottles, but | always add them into transparent base or
screenprinting ink. | mainly use them if | have trouble mixing a dark and very transparent color. Other
respected brands of water-based inks include TW Graphics and Jacquard.

adding sheen to a finished print

Another non-silkscreen acrylic material | use sometimes is Acrylic Gloss Medium, which, mixed
with Speedball’s Extender Base, makes a nice semi-gloss sheen on a finished print. Print two coats, each
one flooded. The first coat should be 2/3 Extender Base and 1/3 gloss medium, with enough water
added that the mixture will drip off a spoon (probably about 20% water). The 2™ layer can have up to
2/3 gloss medium. Materials keep changing, so experiment, but be wary of getting acrylic permanently
stuck in your screen, or your print inextricably stuck onto your screen, as happened the one time |
tried gloss medium without any extender base or added water. Always clean your screen immediately
after printing with acrylic medium, and use soap.

Speedball makes an Overprint Varnish for the specific purpose of adding more gloss to the surface
of a finished silkscreen, but | have found out, the hard way, that it never quite loses its stickiness. When
| use Arches 88 Silkscreen paper, which is about the least rumply paper around for printing with water-
base inks, tiny white paper particles from the print above it will stick to the varnish when | stack a large
pile for any period of time. | always did hear that it’s a good idea to interleave glassine with finished
prints when you stack them, and now | wish | had.
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REGISTRATION

3-point registration

A common and simple kind of registration is 3-point registration, which is generally quite effective.
| use it in both class and studio..

If you are working from a master drawing or photo transparency, use that for a registration key:
Tape it where you want it on a piece of printing paper (usually centered or with a little more space on
the bottom than at the top) and LEAVE IT TAPED ON. Always register with the same size paper you'll
print on.

With two little pieces of tape, temporarily secure this “key drawing” onto your work table. When
there is already a stencil on the screen, you can use the handle trick (see below) to more easily place it.
If this is the first stencil, start the bottom of the image about 4” away from the frame, to leave room for
your squeegee to rest. If the image takes up no more than half your screen, you can leave the other half
open, ready for a future stencil.

Now, set your three points. At class, we use %"-wide artist’s tape that | often call registration tape,
because three layers of it equals the thickness of the printing paper, which is what you need your
registration guides to be. (Masking tape is thinner.) Place the guides against the two edges of the lower
right corner, plus a third guide just below the lower left corner. The guides should be exactly, precisely
along the edge of the paper.

Why not surround both those lower corners? Because the paper, for various reasons, may not
always be exactly the same size. With just three points, that won’t hurt your accuracy. Also, once you
get some practice, you may find you can register mostly by touch: Get the paper slightly farther from
you than the guides are, and set the right-hand corner into place first. Use your right index finger
pressed down on the corner of the paper to make sure it is right against the guides. Maintain enough
pressure to keep the paper from shifting while you place the left side. Hold the left edge of the paper
an inch or two from the front corner, between your left thumb and index finger, and pull it down until
you feel the paper hit against the guide.

Another important thing is to register to the same corner, for each color of a multi-stencil print.
Normally it’s the lower right, but if you're left-handed, or if it better suits your set-up, you may prefer
the lower left. Sometimes special circumstances may dictate their own variations. So note on your key
drawing the placement of your registration guides, especially if you're working in a classroom, where
someone else may have to move your registration marks before your next class.

If you're making a block-out stencil, you'll be able to use the same registration guides for both
creating it and printing it. After you have dried your finished stencil and double-checked it up to the
light, you will set it back in the hinges, not yet tightening them, with the registration key drawing taped
to the registration guides. It’s easy to slide the screen from side to side in the hinges, to find the exact
right spot. If you have your own work table, you may be able to use the same registration guides
through the whole edition.

To register deckle-edged paper, either use a paper trimmer on the bottom and right side, or, to
preserve most of the deckle, just trim the two corners with scissors, as unobtrusively as you can. You
may shorten the guides to % inch so you only have to trim that much. To preserve the entire deckle,
try pin-hole registration (see below).
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the handle trick

When you don’t have registration guides in place, but do have a key drawing, or any layers already
printed, here is the tried and true technique for accurately placing your paper under the stencil:
Eyeball it as best you can, then set the screen down, then lift it a little, adjust the print, and repeat. And
repeat. If the registration’s not too picky, this may not be much bother, but when you need precision,
it can be seriously aggravating,

There is a better way. A visit to Dennis O’Neil’s silkscreen class at the Corcoran, soon after | began
teaching at the Art League, was an eye-opener. A student took a strip of left-over printing paper a
couple inches wide and about a foot long, and taped it to the back of a registration key print, sticking
out like the handle on a mirror. She could then maneuver the image under the screen while the screen
was lowered.

Why didn’t | think of that?

Make sure the handle is well-secured so it won’t wobble. Once you get the placement right, you
can tape the handle to the table, lest the paper shift, before you raise the screen. Tape the print itself to
the table, and set your 3-point registration guides. For even greater ease and precision, you can use two
handles, one on the bottom and one on a side.

Sometimes a partly-finished print can be a more accurate guide than the original key drawing as
you determine how to place a new stencil; sometimes it's even smarter to check both.

acetate registration: the hinged flap

There are some situations where you need another alternative. Suppose you want to printona T-
shirt or extra-large paper that sticks out farther toward you than the table does. Or suppose you want
to use your stencil in a free-form way, not always in the same place on your image—but you want to see
how it'll look in various arrangements. Or suppose you've used the handle and 3 points, and thought
you registered everything just fine, but when you start printing, it's somehow way off, and now the
ink’s too dark to let you see through the screen anymore.

Here’s what to do: Take of piece of acetate or other transparent, flexible sheet of plastic, that is big
enough to cover the open area of the screen and also extend past the paper (or fabric) on one side.
Hinge it on that side, attaching it to the table with a piece of masking tape along the edge, that allows
it to fold back. If there are registration guides in place, even if they’re in need of adjusting, don’t quite
cover them with the plastic.

Set the printing paper or fabric in place under the hinged acetate. Double-check that the acetate
covers all the open area, so you won't accidentally print anything onto the paper or shirt beneath it.
Now lower the screen and print onto the plastic. Raise the screen, and you'll find you can see right
where your color is going to land. With the plastic sheet in place, maneuver the paper or fabric
underneath it until you are happy.

If all you needed to do was to adjust the registration guides, you can remove the acetate once they
are corrected. If registration is inconsistent, whether by error or design, you need to use the plastic for
each copy you print. Fold the plastic back each time. Since it will be wet at first, curve the wet part
under, so the ink won’t touch the table.

pinhole registration

Many printers like to use a precise method called pinhole registration. After I'd been printing a few
years, some poorly-illustrated screenprinting manual mentioned pin-hole registration, and | used to try
to picture it. | was imagining a pin-hole like the point of a needle or pin, and was puzzled. No internet
to consult in those days. In any case, 3-point registration was working for me. With the large paper |
was printing on, my main registration problems were caused by changes in the weather.
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It turned out that there is such a thing as a registration pin, which is exactly the right size to fit into
a hole punched with an ordinary hole-punch, notebook-paper sized. You can punch holes in your
paper with a 2-hole punch and trim it down later. Alternatively, onto each print, you can attach 2
plastic tabs sticking out past the bottom of the paper, attached to the back. With the tabs, you can
even print a “bleed,” which is to say, print all the way to the edge of the paper. Without tabs you can’t
do that, because there would be no way to pick it up while wet. | don’t advise trying a bleed on a
greeting card, because you're bound to print some bit of ink onto the table, which will end up on the
back of the paper, marring your message.

You can either buy the tabs or make them out of plastic, such as frosted Mylar, cut about 1%”
square, or a little bigger, with the corners rounded on one side. Punch a hole in the middle of the
curved side; the other end will ultimately be attached to the back side of the print. The pins are solid
metal, stainless steel maybe, and are attached to a very thin metal plate that you tape down to your
printing table. For some reason the pins are outlandishly expensive, but then, you really only ever need
two of them. The other trouble is that | can’t seem to find, lately, pins that are short enough to not
make me worry about them poking a hole in the screen. | suppose the bottom of the screen fabric
could be protected at those points with a couple layers of tape.

There seems to be some difference of opinion as to whether the pins should be down near the
printmaker or up toward the hinges. My opinion is, if | had to reach all the way up past the print to
register, under a screen full of ink—especially if it was flooded—I would get ink on my hands, and maybe
on the print, and make a big mess.

Here’s how to place the pins and tabs. If you want to punch holes directly in the paper, take a 2-
hole punch (or 2 holes of a 3-hole punch, if you're working small). Punch two holes in the lower edge
of all your sheets of printing paper, as well as your key drawing (mounted onto printing paper if the
two are not the same size). Try to be reasonably consistent in your placement of the holes, so the
prints will all be more or less centered on the paper. Now, take the key drawing, and tape it in
registration under the screen. Poke the two metal pins through the punched holes from underneath.
Tape the pins securely to the table, and you're ready to print.

If instead you are using individual tabs, attach the tabs only to the key drawing, at first, perhaps
1/4 and 3/4 of the way across the bottom edge of the paper. Tape the key drawing in place on your
printing table, and stick the tabs into the loose pins. Tape the flat parts of the pins securely to the
table. Now, use the pins to show you where to attach the tabs to all the rest of your paper: for each
sheet, stick the tabs through the pins, with the sticky side of the tabs face up and toward your paper.
Double-sided tape may work well, if you make your own tabs. Set the paper onto the tabs, roughly
centered or with guidelines on the table marking about where to place the side edges of the paper.

Make sure not to remove any of the tabs until you have printed all colors onto the edition. If you
have to change the placement of the pins for later stencils, or re-place pins you've removed from the
work table, that is no problem. Any pair of holes will show you where to put the pins, when you tape
your paper into register under the screen.

x marks

Cross or target marks in the 4 corners, just outside the image, are another possible registration aid.
They can be computer-generated, pre-printed, or drawn by hand onto your registration key. Make
them a part of each stencil, and try to get them to all line up with each other when you print. If you
don’t want the marks to show, use them to get your registration just right and then cover them with
tape on the under-side of your screen, before you print the rest of the edition.
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PRINTING TIPS & TROUBLESHOOTING

GAINING CONTROL AS YOU PRINT

You should already know the basics of pulling a squeegee along a screen. (If not, see the “To Print”
section and watch others printing.)

But since there is a lot more to the process, let’s talk about some of the issues.

So many factors affect the printing of an image, it is frustrating to discover just how many things
can go wrong. But take heart: Most of these factors can be brought under your control, and then can
be used as multiple ways to attack problems that arise. The most important thing | can say is, learn to
notice how wet or dry the screen is while you are printing, which usually corresponds to how
much ink you are putting through it.

Some variables are determined when you make the stencil: for example, the fabric mesh.

A coarser mesh has a higher proportion of open area, allowing more ink to pass though than does a
finer mesh. This is what makes a coarser mesh (137 - 195) better if you are printing onto fabric, which
tends to be very absorbent. Less space between the threads, with a very fine mesh such as the 230
mesh of our yellow screens, gives more places to attach the teeny tiny dots of a half-tone’s light grey
areas, and allows the finest resolution for small-scale text. But a mesh this fine always lets through less
ink, resulting in a screen that is more likely to dry out while printing.

Also, large open areas will stay wetter while printing, and dry more slowly (sometimes a lot more
slowly!) on the drying racks, than thin lines and small details.

Another variable is the weather. Everything dries faster when the air is dry, slower when it’s humid.

As you learn how to adjust your technique to the conditions, there can be unintended
consequences to deal with. For example, flooding will keep your screen wetter with ink, but at the
same time, the ink itself will dry out faster, due to increased evaporation when it’s all spread out in a
thin layer. If you're flooding and the air is dry, you should either mist the screen with water periodically
(not in the open area) or add Retarder Base, or at least keep scooping stiffer ink back into the mixing
bowl and adding water.

It'’s all a matter of balance. If you overcompensate, back off. It’s perfectly fine to use just one pass
most of the time, with an occasional floodcoat when there’s the first sign of ink drying in the screen; or
to tweak your technique with different combinations of the suggestions | offer below.

TROUBLE-SHOOTING

Q: Why are some of my fine lines, or the lighter parts of a half-tone disappearing?
or
Q: Why is the print starting to look hazy around the edges?

A: If this just started happening in the middle of printing, it probably means your ink is drying in the
screen. Maybe you’re not sending enough ink through, or maybe you're waiting too long between
passes. Remember not to leave an inked screen for more than a minute or two without printing (onto
scrap paper if you're not ready to resume printing on your good paper).

If these fine lines or sharp edges, didn’t print from the start, it’s probably a stencil problem, or,
perhaps, insufficient pressure. Cut stencils, because they have thickness, frequently won't print all the
way to the edges on the first pass or two, but then will do fine.
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First, clear the dried ink out of the screen. Flood the screen and leave it raised for a minute or so.
Then print out onto scrap paper with a very firm squeegee pressure. If that doesn’t open up the dried
parts, try the same thing again, but use a forward-and-back scrubbing motion with the squeegee, to
really force all the ink through the screen onto the paper. If scrubbing is required and successful, it will
most likely push some ink onto the bottom of the fabric where you don’t want it, near the edges of the
open area. So, print again onto scrap paper until that excess is gone.

If some dried ink still clogs the screen, take a damp rag on the top and a dry paper towel or Kleenex
on the bottom of your raised screen, and rub from both sides at once. You should be able to see if the
screen is cleared. If it is, resume printing, again using scrap paper for the first pull. If not, try using a
damp rag on each side, which is a little bit messier and will require drying the underside of the screen
with a paper towel and probably a couple times printing onto scrap.

If that doesn’t do the trick, scrape the ink off the screen and go wash it at the sink. If any dried ink
STILL won’t come out, that may mean it’s old ink you let dry into the screen after printing last time.
Still at the sink, spray on a little Simple Green. If it’s a photo emulsion stencil, Simple Green won’t harm
the stencil at all; scrub it and spray it until the ink is gone. A Screen Filler stencil will start to dissolve
with Simple Green, so use it very cautiously, working with a small part at a time, and rinsing it out
quickly. Expect to wash out a little more of both ink and stencil when you rinse off the cleaner. Repair
stencil if needed.

Should the problem be residue of a previous stencil, a small speck may come out with acetone on
two small squares of Kleenex, rubbing from both sides of the screen at once. Or, depending on the type
of stencil, you can use its regular remover to spot-clean. At a certain point, it’s time to give up and
clean everything off the screen, with a power washer if possible.

To keep it from happening again: print “wetter”:
(don’t try all these things at once!)

« Use a floodcoat or two passes (generally not both, unless printing on fabric).

« If you were already flooding, just before printing, try flooding just after printing instead.

« Pick a duller squeegee.

« Hold the squeegee at more of an angle from upright; 40° rather than 30°.

« If the ink consistency is too stiff, add water to the ink.

« If the consistency seems all right, but it's drying too fast anyway, try adding Retarder Base, a
spoonful or so into a bowl of ink. Put leftover ink into its own mixed-ink container, and write
“w/retarder” on a piece of masking tape on the lid.

+ Don’t leave the screen raised for too long without printing.

« Every so often, try misting the screen with water, but not in the open area, where it will keep the
ink from printing. The safest way is to flood the screen, then mist it along the ink near your
squeegee, SO it mixes in as you print.

Q: Why is ink is squishing out past the edge of the open area, or messing up fine lines?
or
Q: Why are the details filling in too much on the dark parts of a halftone?

A: Probably too much ink is being pushed through the screen. It spreads past the edges of the open
area, on your paper and also on the underside of the screen so that it will transfer onto your next print
as well.

First, print onto scrap paper, using a single pass, to clean the excess ink from the bottom of the
screen. You may have to do this more than once.
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To keep it from happening again: print “dryer”:

« Try using only one pass (without flooding) or try flooding instead of a second pass. A second pass
can sometimes blur your image when a single floodcoat will not. Take care not to run out of ink
while flooding, since a second floodcoat has more chance of squishing past the stencil edges.

« If you have been flooding right after printing, try flooding right before lowering the screen instead.

« Pick a sharper-edged squeegee.

« Hold the squeegee at a more upright angle.

« If the ink consistency seems watery, try adding or switching to stiffer ink.

« Pause before you print the next impression, to give the screen a little air time.

Q: Why is one area not printing at all?

A: If no ink is lodged in the screen in an open area, the cause is simple: You ran out of ink.

Solution: Add more ink. Remember that a large open area will use a lot more ink than an area
that’s partly blocked by the stencil. As you print, watch how much ink there is on the front side of the
squeegee. If it looks like you're running out, mid-pass, sometimes you can squeak by if you increase the
squeegee angle, to print the ink that’s resting on the front of the blade. Flooding takes more ink than
printing, so if you notice the skip before lowering the screen, you can add ink to the squeegee and
flood again. Then print once onto scrap paper, especially if the ink is a gradient (color fade), because
the color may not look quite the same. Also, squeegees seem to carry along bits of dirt or dried ink
without depositing them until the ink runs out. So, after printing on scrap paper, take a look at your
screen to make sure nothing’s clogging it at the edge of where you ran out.

A: If the ink that was supposed to print can still be seen in the screen, it means you didn’t get good
contact in that area. Another clue is that the ink bordering the missing part is a thicker than normal
and/or bubbly, suggesting the squeegee can push the ink through the screen but not scrape off the
excess. (This is something you'll see around the edges of a cut-out stencil, too, since the thickness of
the stencil prevents good contact at the edges). When contact is so bad that the squeegee can’t reach
the paper at all, then it skips.

Check:

Is the stencil especially thick in that area, such as two pieces of contact paper overlapped?

Is something holding the screen a little bit up from the paper?

Is your squeegee too long or too stiff, so that the slight unevenness of a table is enough to

prevent good contact?

Q: What can | do about leaks in the stencil, that make it print where it shouldn’t?

A: A line-shaped leak can be caused by the edge of the glass, or even the edge of your transparency
film, partially blocking the light during exposure of a photo stencil. If the leak is near the frame of your
screen, it is likely the result of any kind of stencil not quite extending to the polyurethaned edge of the
fabric, or else deterioration of the polyurethane itself.

These can usually be fixed on the fly with a piece of masking tape on the bottom of the screen. Use
an extra-long piece of tape if possible, since the dampness on the screen will make it harder to stick
down. Obviously, leaks are easier to fix, with tape, block-out, or contact paper, before you begin to
print, so remember to hold the screen up to the light to check.
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A: With a block-out screen, if the ink comes through in a hazy way, you probably didn’t completely
block the screen when you painted on the Screen Filler. Or else you didn’t dry it enough before
washing out resist or before printing. Sometimes a partially blocked screen can be a nice effect, not
necessarily to be avoided (unless you wish to).

But if the stencil continues to deteriorate, that’s a problem; it means the screen filler is still
dissolving. You can slow it down by waiting a couple of minutes to print, after you first notice it. Use
no flooding, just one pass. If there is improvement, continue to pause between printings. You're trying
to dry the screen just enough that drying ink repairs the stencil. It can work, but it’s a tricky business.
Don'’t put too much pressure on the squeegee; the last thing you want to do is force this drying ink
onto your paper. If there are lots more copies to print, or you can’t dry the ink on the stencil without
drying the ink in the open areas, you may need to clean the ink off the screen and repair the stencil.
Use a very gentle spray of COLD water to get the ink off, avoid Simple Green, and still expect to lose
some more stencil during wash-out.

A: With a photoscreen, bits of dust on the screen or glass can create pinholes in the emulsion by
blocking the light during exposure. Also, there is a certain kind of teeny, almost invisible pinhole that
may, occasionally, cover large areas of the screen. | really hate to see these, and am glad to say | haven'’t,
lately. But I've still never figured out exactly what causes them. It may be at the coating stage; the
emulsion may be too bubbly, or we may be pulling the scoop coater too fast. Wash-out may be part of
the problem. It’s never happened when we double-coat with emulsion by pulling the scoop coater up
the screen twice in quick succession, so you can try that as a general practice if you have this problem.
Then, let the emulsion dry just a little longer before exposure than if it were a single coat.

If you notice pinholes before printing, you can fill them with Screen Filler, or contact paper on the
underside of the screen. If they don’t show up till you're printing and it’s too near the image to block
with contact paper, there’s some possibility that if you print gently enough and dry enough, and pause
between passes, the ink itself will fill in the pinholes rather than print through them. (See above.)
Otherwise you'll have to repair or reshoot.

Q: What's this little white speck that keeps showing up in the same place?

A: If, as soon as you start printing, there’s a little place where ink won’t go through, it generally means
that the screen still has a trace of old stencil or dried ink on it, unless it’s just a little crumb on the
bottom of the screen. If there are lots of teeny specks, you may have gotten lint on the screen (usually
on the underside) from a paper towel or rag. Lint should be removable by blotting gently with damp
Kleenex, or, if there’s not much ink on the screen, wiping the underside with the palm of your hand.
Old hardened stencil would need to be cleaned out with either emulsion remover or Awesome Orange
or possibly acetone, on small squares of Kleenex, attacking the residue from both sides at once.
Depending on the extent of the problem, that might or might not be doable without stopping the
printing and cleaning the screen.

If the speck doesn’t show up until later, after the stencil printed fine at first, it's usually caused by
either some tiny crumb that you can pick off with your finger, or else a fleck of dried ink that got mixed
into your printing ink and then stuck in the screen. Put water on small squares of Kleenex, and rub at
the speck of dried ink from both sides at once. Usually that works. If not, try alcohol or diluted Simple
Green on the Kleenex. (Always rinse off Simple Green.)
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Q: What if the same batch of ink keeps having problems? | clean out flecks of dried ink and just
keep getting new ones.

A: Then the ink needs straining. A paint strainer is a circle of sheer, wide-mesh fabric surrounded by
elastic, available in gallon and sometimes quart size, where house paints are sold. My technique is to
stretch the elastic around a bowl (or jar), with the middle of the strainer resting in the bottom of the
bowl. Pour the ink into the bowl, making sure you've scraped all you can off your squeegee and screen.
Now, lift the elastic above the bowl and gather together those edges in one hand, so that you have the
ink in sort of a bag, still sitting in the bowl. With your other hand, cover the bowl! with a wide plastic
paint scraper (about 6”), with the gathered fabric sticking out between the scraper blade and the edge
of the bowl. Hold the scraper tightly enough to the edge of the bowl that when you pull on the bag to
gradually remove it from the bowl, the ink will squeeze through the strainer into the bowl. If the
strainer still contains much of any ink, pull it through again, with more pressure. As you remove the
scraper from the bowl, wipe off the ink on its underside into the bowl.

If you rinse the “bag” with all its edges still in one hand, you'll likely find lots of bits of dried ink and
usually a few other mysterious specks. Wash all those specks down the drain, and the ink in the bowl
shouldn’t give you any more trouble.

Q: What is this line of really thick ink on my print?

A: That is usually ink the squeegee didn’t scrape off, either because the squeegee is too small and the
edge of it is leaving a trail of ink, or because the stencil is too close to the lower edge of the screen, so
that the squeegee rests on the open area. You can also get a ridge of ink if there’s a nick in the
squeegee blade. Switch squeegees (or try reversing the squeegee) and it can be sanded down later.

Q: Why does ink keeps clogging in my screen, even though it’s plenty wet? | just cleared the
clogged ink all off my screen, but now it’s happening again.

A: If the ink is a good consistency and is not drying out, it’s possible that your prior color is still a little
wet. It can stick to your screen, mixing with the new color and clogging up your mesh. Wait longer. Or
if there are only a few to print and you're in a terrible hurry, clear the clogged ink out again and use the
hair dryer to briefly dry your paper or fabric before printing, each time.

Q: | thought | had this registered, but now it’s not lining up right. What’s wrong?

A: It may be that the print you used to register by is not consistent with the others. Just use acetate
registration one time, to reset your guides. It’s also possible one of your hinge-clamps is loose, or that
you are using a different corner to register to, which could make trouble if there’s any variation in
paper size. Could be, too, that you don’t have enough layers of registration tape to keep your paper
from shifting around. If your paper is very curled, so that it’s hard to keep it in register, you could try
some double-stick tape (or adhesive spray) on your table to make it less slippery, or even tape each
print down to the table before lowering the screen, as a last resort.

Sadly, it also may be that you had one of these problems the LAST time you printed, and never
realized it till now when you tried to line it up with your new layer. If that’s the case, and your
registration is inconsistent from one impression to the next, your best bet may be to use the hinged
flap of acetate for each print, till you've finished this run. Once the prints are dry, take a good look at
them, and sort them; sometimes you can use 3-point registration for most of the edition and just use
the acetate for whatever outliers are worth saving at all.
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Because inconsistent registration is the hardest thing to deal with if you'll be printing a lot more
layers, | usually don’t even try to fix a registration mistake that is consistent, if | don’t discover it till I'm
in the middle of printing that color. There’s bound to be some way to fix it or make it look intentional,
later, so long as all impressions are the same.

Then, too, imperfect registration is pretty much a hallmark of silkscreen printing; look at Andy
Warhol’s Marilyns, with colors intentionally offset a good half-inch from each other. Some “misprints”
can create two different planes in space, or a shadow effect, that’s interesting. As always, try to be
flexible enough to welcome the “happy accident.” Sometimes that’s about all you can do.

Q: How can I stop getting these horrible “lift marks” ?

A: Unfortunately, lift-marks are another common characteristic of the medium. They occur when the
paper separates from the screen mesh in an uneven way, immediately after printing. You can watch it
start to happen before you even raise the screen. Water-based inks are particularly vulnerable to lift-
marks, because the water in the ink makes the paper rumple. When paper won't sit flat, lift marks tend
to be pronounced and ugly. This is why we try to print on very thick paper or posterboard. If you print
on heavy matboard or illustration board, you should not get any lift-marks at all, so long as your frame
and table allow the screen mesh to have good, even contact with the printing stock.

Off-contact printing: Hinge clamps intentionally hold the far end of the screen 1/8 inch or so off
of the paper, on the theory that the best way to avoid lift marks is to allow the screen to touch the
paper only where the squeegee is immediately passing over, the “off-contact” technique. The printer is
supposed to build up the front corners of the screen to the same height. But here is the truth: off-
contact printing only works if you are printing on a vacuum table, which | have never had opportunity
to try. Otherwise, lift marks are much worse with an off-contact screen, at least when using
water-based inks, which can’t seem to help rumpling the paper at least a little, especially if you are
printing any large open areas. You can get some of the effect of a vacuum table by applying double-
stick tape or spray adhesive to the printing surface, so the back of the paper will stick down. Some
students tape each print down with removable tape. Any of these techniques could potentially
damage some papers, so | don’t recommend using them for fine art printing on expensive paper.
Nevertheless, feel free to try them.

If you are printing very fine detail, such as text or a line drawing, you may not have large enough
open areas to be troubled by lift marks or rumpling anyway. Then, if sharp-edged precision is your
goal, it may be worth considering that off-contact printing is said to give you a less-blurry line or edge.
Experiment with building up the front corners of your screen with cardboard. Make sure the stencil is
at least a few inches from any edge of the frame, so you won'’t exert such force on the fabric as to pull it
away from the frame. I'm still not sure it would work without a vacuum table, adhesive or tape, to keep
the paper in place. But it might, especially if you use registration pins.

For my own printing, | use a hinged backboard clamped to the screen, rather than hinge clamps, to
get the best possible contact. Back when | was stretching my own screens, | used to stuff long strips of
heavy paper between the fabric and the frame it was stapled to, which increased the tension as well as
ensuring that the frame or staples wouldn’t prevent the fabric from resting flat on the paper.

If you prefer hinge clamps, it may be possible to rout out your work table, or build up the printing
surface, so that the lowered clamps sit flush with the printing surface.

Regardless of your set-up, if there’s too much spring to the mesh when you press down on it, you
can build up the printing surface by taping on a piece of matboard or Plexiglas that is bigger than the
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paper but fits inside the frame—-often the issue is that the frame sticks down a little farther than the
mesh. (Don’t use corrugated cardboard or your print will look corrugated too!)

Lift-marks often look worse when they’re wet than they do once they’re dry, but don’t expect
them to go away entirely, unless they are mainly just a matter of bubbles, which will settle out some as
they dry. Opaque colors may turn out fine, whereas with transparent colors, wet or dry, a thick layer of
ink is going to be darker than a thin one, and bubbles will dry into tiny circles, light in the middle.

One thing to remember: If you're seeing lift-marks or bubbles in the first color of several layers you
have planned, the problem may be hidden by later layers. Check where in your image the lift marks are
occurring, and if you can see they’ll be covered, don’t worry about them. Even if they won't be hidden
exactly, they are guaranteed to be much less noticeable, especially if your first color is a faint one. Every
tiny discrepancy in your ink is noticeable when all you can see otherwise is one faint color against
white paper.

Here are some more ideas to minimize lift-marks:

The more absorbent your paper, the less lift-marks will show. Posterboard is not good in this
regard, but the matte side is better than the shiny side, if lift-marks are an issue.

To compensate for any warp in your frame or table, put a few small squares of posterboard or
cardboard between the bottom of the frame and whichever hinge-clamp needs it.

When choosing or mixing your ink, know that drippy ink will make worse lift marks, and more
bubbles, than stiffer ink.

You can let the just-printed image dry a minute or two, and print a second time.

Or let it dry all the way, and then print the same color again. This will naturally darken a
transparent color and make an opaque color more opaque.

If the print is sticking to the underside of the screen, you can sometimes lessen the lift marks by
raising the screen, pressing the print against the screen even more, and then pulling it off with a
smooth motion. Just don’t try to stick down a print that’s only barely stuck on, because if it separates
just as you touch it, it may shift position. The result can be ink smearing onto the image from the inked
part of the screen.

There are various motions of lifting the screen that sometimes help. One favorite is to use the
squeegee to hold down the screen firmly as you finish your stroke, pause for a second, and then raise
the screen suddenly. Sometimes that will make it lift off the paper all at once. Take care not to make
the squeegee fall onto the screen with this sudden motion.

54 click to go to table of contents NANCY MCINTYRE



MAINTAINING A SMOOTH COLOR FADE

On the first night of class, | ask everyone to try a color fade, or gradient: setting more than one color of
ink on the screen and blending the colors together with the squeegee, so that the color on one end of
the squeegee fades to a different color at the other end. Another term for this is a mixed fount.
(There’s also such a thing as a split fount, when you print two distinct colors on two separate parts of
your print.)

Almost every time | add a layer of ink to one of my silkscreens, | ask myself if there’s anything to be
gained by using a color fade, and more often than not the answer is yes. But | try very hard to do just
about the same thing to each print in the edition, especially since inconsistencies will affect future
transparent layers. That's not too tricky when there are just two colors, especially if they are not even
very different from each other. It’s usually with a big color change, using 3 or more different mixed inks,
that things can get out of hand.

How do | keep a fade smooth and consistent? Try any of these steps that seem useful:

1) After completing your stencil, draw lines with crayon, china marker, or pencil, directly on your
screen, in the direction your squeegee will be moving, to show where you want to shift from one color
to the next. You can even mark whether the shift should be quick or gradual, by indicating how much
to overlap the colors when you lay out the inks. Draw all change-points on the blocked area of the
stencil, for several inches above the open area. (Don’t draw on the open area.) If it helps, you can also
draw side lines by holding the crayon against each end of the squeegee as you move the squeegee
across the image just like you will when you print, to help you keep on the same path each time you
pull.

The lines may get somewhat concealed by inks or worn off eventually, and can be hard enough to
see at the near edge of the screen that instead of lines there, | usually just put a piece of colored tape
on the frame, right where I'll aim the nail in the center of my squeegee. Or, mark with tape where to
aim the two edges of the squeegee handle.

2) Mix up the various inks and proof once, without worrying about the blend being too smooth. A
kind of stripey look will help you judge the individual colors, especially if there are more than two.
Remix as necessary.

3) If two adjacent colors are dramatically different, take a spoonful of each to mix an intermediary
color, to place on the crayon line between the two colors, at least at first.

4) Proof until the colors seem about right. Line up the bowls of ink in the same order you will be
spooning them onto the screen. If there’s any question about the color, allow the proof to dry, to see if
it still looks right. If short on time, you may be able to leave the mixed ink on the screen and use the
hair dryer for a minute or two on the wet print, to indicate pretty well how the color will look when
dry. This is especially helpful if Extender Base is making the ink look a lot more opaque than it really is,
over a dark or deep color.

If time allows, and the screen is messy or drying out, or you want to make any major change, wash
off all the ink and dry the screen.
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5) For final printing: Spoon on the inks according to your crayon lines, keeping the line of ink a couple
inches back from the open area, if possible. Put on enough ink to print maybe 10 times, more or less.
More if the open area is small, less if it’s large. If you want some parts of the fade more gradual than
others, overlap those colors more as you set them on the screen.

6) Use the squeegee to stir the colors together till the gradient looks like what you want. The stirring
motion should be back-to-front and front-to-back more than side-to-side, so that the ink on the
squeegee is about the same blend as the ink on the screen.

This stirring can be done with the screen either lowered or slightly raised, but if it's lowered, and
the screen is not tight against your paper, the stirring action may shift a small print out of registration.

7) Leave the squeegee-stirred ink in a kind of flat pile, maybe 1/4” high and a couple inches wide (and
the length, of course, of the squeegee). From this pile, each time, draw only what you need to make
sure you can complete one pass. (The very first pass, on the dry screen, will take a little more than the
others.) Remember that large open areas will take the most ink.

Every pull of the squeegee causes the ink to flow and drift outward from the center of the
squeegee, if you are pulling it straight. When you are not pulling much excess ink across the screen, it
will flow less, and then match better with the original fade pattern, when you get back to the reservoir
to pick up more ink for your next stroke.

If you are pulling the squeegee from the side of the frame, for a blend in that direction, it’s trickier.
Raising the screen can make the ink flow downhill some, though leaving it in a flat pile will make that
happen less. Downhill drift can be counterbalanced by pulling the downhill edge of the squeegee
slightly ahead of the uphill edge; watch the ink move along the front of your squeegee, and try to keep
it as close to the designated crayon lines as you can, as you proceed to print the edition.

8) When you start to run low on ink, if you catch it in time, you can add each color right in the middle
of where it belongs and let the colors mix themselves as you print. If you are flooding, flood the screen
and THEN add the ink, while the screen is raised. Also, you may periodically want to drop a spoonful of
the ink that has flowed off the side of the squeegee back where it belongs, to counterbalance the effect
of outward flow.

9) Don’t cut it too close; running out of ink is likely to ruin one print; before you pull the squeegee
each time, make sure there is enough ink in front of it to make it to the other end of the image. If you
do run out of ink, and catch it before you raise the screen, make a second pass without raising the
screen and without delay—except first add a bit of ink, unless you can make do with a more horizontal
squeegee angle. Angling the squeegee more is likewise a thing to try if, in the middle of a pass, you see
you're at risk of running out. It will use some of the ink that’s on the front surface of the squeegee.

Flooding takes more ink than does a pass onto paper. A good aspect of that is how you never need
to ruin a print by running out of ink: if you run out while flooding, just print on to a piece of scrap
instead of good paper, add ink, and flood again.

10) When you need to replenish everything, spoon the inks on, but don’t start stirring with the
squeegee until you check to see how the ink on the squeegee corresponds to what you've added. If the
colors are still in roughly the right place, the ink on the squeegee will help you mix a smooth blend
quicker than you could the first time. But if the squeegee ink has drifted and muddied too much,
remove that ink and save in a separate jar or bowl.
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Indeed, any time colors have drifted too far, even if there’s plenty of ink on the screen, scrape off
the muddy part and replace that section, or lay out a new row of everything. Since pushing around too
much ink is often what causes the trouble, don’t mix good ink into bad just because you hate to waste
ink. It’s all savable and good for mixing something else later.

11) Sometimes | want two different colors, and don’t want them to blend into a combination color. |
lay down two flat piles of ink without overlapping them, one color coming right up to where the other
one starts. Then | can just pick up enough ink from the front of the flat pile to complete each pass. |
duck my head down a little so that | can actually watch the ink on the front of the squeegee as | pull it,
and make sure the dividing line prints right where | want it.

With any color fade, looking at the ink on the front of the squeegee as you print will help you see
where the different shades of ink are landing. If you need to adjust but you don’t want to shift the
whole path of the squeegee left or right, try adjusting just one end of the squeegee, till the flow of ink
toward the sides of the squeegee is even.

12) Fancy stuff: If you want to print a diagonal or curved color fade, maintaining consistency is much
more difficult. In fact, for a straight diagonal pull | recommend creating that stencil on the diagonal, if
the paper is small enough to turn on the diagonal as well. Then the pull can still be straight toward the
edge of the frame where you are standing, if you can reach well enough to register by the same corners
of the paper.

But sometimes the thought of the diagonal only comes after the stencil is made. In this case, if
using a small squeegee, you may be able to set a second squeegee at the same angle, rested against the
screen (or taped to it), to lean your squeegee against at the end of the pass.

The more complicated the pull, the simpler you should make the fade, usually just from one color
to a second, with or without the natural intermediate. Also, be especially careful in marking with tape
and crayon the intended path of your squeegee.

Often the best plan is an s-curve, which will help balance out the centrifugal force of the curve.
What you don’t want is for one end of the squeegee to continually be the leading edge, so that the ink
keeps running toward the trailing edge. That’s a good principle to remember for straight pulls as well.
(See step 7.)
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STACKING AND SIGNING PRINTS

| tell my classes to print extra copies when making a multi-layer print, because with each layer, at least
one or two copies will likely be lost to misprints, fingerprints, or color-tweaking. Since | admit to
putting 50 or 100 layers on many of my own silkscreens, | have been asked, “How do you keep from
wrecking your whole edition?” Well, | do start with twice as many copies as | want to end up with.
But the real key is to wreck mostly the same copies, over and over.

Here’s how to do it:

As you take the prints off the drying racks, stack them with the best ones on the bottom and the
worst ones on top.

If it’s a large edition, let’s say over 20 or 30, here is the order in which | stack them:

1. (On the bottom of the pile): All the ones that look just right, or almost right

2. Any that might very likely be fine once the rest of the colors are on

3. Any that are possibly salvageable, eventually, as good ones, or as interesting variations (perhaps a
color fade has drifted or is streaky)

4. Whatever messed-up ones seem most useful for determining the next color, or registration

5. Thereally bad ones. Even these are worth not only saving, but printing succeeding colors onto,
since succeeding layers often bring them back to #4 useful status

Well, you might want to leave a half-way decent one on the very top, so as not to discourage yourself
when you look at them.

Sometimes | change the angle of the stack when | get to change-points, since I'll need to reach
down and print on one that has the colors right, to make a final determination on the next color, and |
don’t want to run out of misprints before I've got the new color right. As a general rule, | set aside most
of the really bad ones to print last, in case | run out of ink, or if something goes wrong during printing.
Almost anytime you have to fix something in the middle of printing, it's a good idea to print next on
either scrap paper or a messed-up copy.

To stack the worse impressions on top of the better ones turns on its head the general notion in
the printmaking world that lower numbered impressions in a edition are the most valuable. That idea
never has made any sense for silkscreen, but | do feel an obligation to not let the lowest—numbered
impressions be the ones that barely make it into the edition. So any that are the least bit questionable,
| move to the bottom of the pile before | start numbering.

Impressions that have noticeable mistakes, variations, or ink in the border, but still seem like “good
ones” | mark as Artist Proofs (APs) instead of part of the numbered edition.

APs are traditionally the impressions that the artist gets to keep if somebody else is doing the
printing. When you do your own printing, | think you can give yourself considerable leeway in how to
use the designation. The printmaking convention is to limit APs to 10% of the edition; | try to stay
close to that. Especially since | use so very many color fades in my work, my numbered impressions can
never be completely identical, but | try to make sure they’re pretty darn close. | allow APs to vary more.
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As you are printing, or later when you're stacking, if you find a registration mistake, make a note of
it in the border. You wouldn’t want to accidentally use that copy to register by, when you print a later
color. If you wish, you can also note when something’s wrong with a particular color, which will make
that copy a poor indicator for how a later color will look on top of it.

Naturally, you can try different colors with the same stencil on purpose. Experimentation is a good
thing. When prints are related but quite different from one another, that is sometimes called a “suite”
rather than an edition, though I'm not sure how to say “suite” when you sign them, or whether any
numbers would be involved.

Anytime there is much variation within a batch of prints, but it still feels like an edition, you can
number it but make the notation that it’s a variable edition: “ev” or “ed var.” You could also just call
them all APs, which will at least be an indication they are prints and not paintings. Or number them
1/1, or just sign them with your name, assuming you like them enough to own up to them.

The general way to number an edition is as follows: the number is like a fraction, with the
denominator always the number of prints in the whole edition. For the numerator, number each print
individually; 1/25, 2/25, etc.

The edition number, as well as your name, the date (often just the year) and the title, if any, are all
written in pencil on the paper just below the image. If the image goes all the way to the edge of the
paper, or you intend to mat it with no border showing, you may write it on the printed area instead.

By numbering an edition, you are promising not to print more of that exact print later, even if you
sell all you printed. The general consensus seems to be that to even call it a “limited edition,” it must be
limited to 200 or 250 prints at most, and that an edition over 100 is certainly not VERY limited.
Keeping it closer to 50 has more cache. These days, with the print boom of the 70s and 80s long gone,
most artist-printmakers set editions much smaller even than 50, because large editions tend to pile up
in the studio.

My studio is further crowded by sets of “printers proofs” that | am in the habit of making and
keeping. Some printers would call them state proofs, since they show the different stages the print
goes through. In addition to showing the print as it develops, | also keep one sheet of printing paper
(usually on the back of an already-ruined copy) that shows what layers have been added since the last
state proof.

To be a printmaker is to be an educator, too: When anybody mistakes a silkscreen for a
reproduction, and asks you about “the original”, you can explain that a hand-printed silkscreen IS an
original. You can ask, “If | gave you one of a batch of cookies, would you consider it a reproduction? Of
what? The original cookie?”
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PRINTING VARIATIONS

POCHOIR, MONO-PRINTING AND RELIEF PLATE

pochoir

Silkscreen printing was developed centuries ago (at least in China and Japan), but the squeegee
only came into use in the 1920s. Before that, the color was pushed through the screen by other means,
such as a stiff brush or a dauber. Such techniques became quite popular in France, and are often called
by the French term “pochoir.” I've also heard it called “mono-printing,” since each one is a little bit
unique, and sometimes | use that term, especially since I still don’t know how to pronounce “pochoir.”

With the fast-drying inks we use today, it isn’t practical or desirable to forgo the squeegee entirely.
Still, some very interesting effects can be had by using brushes to paint differently colored inks through
the screen in small areas, before you pull the squeegee across the whole stencil. Using a brush can be
an easy way to put on some small accent color, and is often a lovely way to create free-form clouds in a
sky, waves in the water, etc.

Place your paper in register, lower the screen, and figure you have a minute or two to paint before
you need to pull the squeegee. Try to paint on exactly as much ink as the paper can absorb; too much
excess will streak into the squeegeed ink. Ideally, print with only one pass. The painted areas will not
absorb ink from the squeegee, at least not much. With a second pass, more of the squeegeed ink will
be laid on everywhere. If the ink is starting to dry out, you can print several passes onto a piece of scrap
paper to clear the screen before beginning the paint-brush step.

The painting must be repeated on each individual print. There will be a bit of a ghost from the
previous impression to guide you.

For different textural effects, you could try using a sponge or cloth instead of a brush.

mono-printing

Another approach that may be termed mono-printing is to use water-soluble crayons to draw
your complete image onto the screen itself, and use a squeegee with transparent base to transfer the
image onto the paper.

While drawing, the screen can be either raised or lowered, but not lowered onto your printing
paper. When finished drawing, raise the screen and flood with transparent base. Allow to stand for a
minute or so, to begin to dissolve the crayon. Set your paper in register, lower the screen, and pull the
squeegee again, pressing your drawing ink onto the paper. If too much of your drawing remains stuck
in the screen, you can check the registration, lower the screen again, and give it another pass. You can
also try flooding with transparent base again, and next time flood for longer.

The part of the screen where you don’t want anything to print should be masked out, using any
sort of stencil.

relief plate

Back in silkscreen class at RISD, in 1971, | mentioned to my teacher Art Wood, one day, that | was
noticing the pattern of the plywood of my portable work station transferring onto some of my
silkscreens.

He said, “Come with me. | want to show you a student who is using that effect to her great
advantage.” This young woman was placing various flattish things (I forget what: leaves? feathers?

60 click to go to table of contents NANCY MCINTYRE



thread?) under her paper and then printing over them, with very interesting results. The transparent
ink was printing heavier in the low spots, and very thinly—and therefore lighter colored—where it was
partly scraped off the high spots.

It is pretty amazing how slight a relief will transfer, especially onto thin paper; in fact a piece of
scotch tape can show up, something to look out for when it’s not intentional.

So, when | am looking for soft textural effects, | sometimes print with a relief plate under my
printing paper. | construct it from cut-out Mylar, paper, cardboard, fabric, sandpaper and/or other
materials which have a texture or on which | can create a texture. | can paint with thick acrylic paint,
emboss a soft surface with forceful lines of ballpoint pen, shave down a thick paper to make it thinner
in places, etc. It is important that the relief be fairly flat and even, since the squeegee has to make good
contact with the paper everywhere, so that there will not be skips in the ink. It also may be necessary
to use a dull, stiff squeegee.

If I'm printing onto lightweight paper, | just place the relief plate underneath the printing paper
while it is screenprinted from above; the ink settles into the hollows and is partly rubbed off the high
spots. With opaque colors, this might not have any particular effect, but with transparent inks, there is
quite a difference between a thick layer of ink and a thin layer of ink. With water-base inks, rice paper is
about the only thin paper I've tried that doesn’t rumple.

To use relief with heavy-weight paper, the process is more complicated. It requires two colors of
ink. The first color is printed onto wax paper or freezer wrap, which is then discarded, leaving a residue
on the screen corresponding to the low parts of the relief. Any excess ink around the edges must be
scraped off of the screen. Then, place printing paper in register and lower the screen. A second
squeegee, with a second color or transparent base, is drawn across the screen in a direction either
opposite or perpendicular to the first. The residue from the first color will print onto the paper along
with the second color. The relief plate is left attached to the table through all these steps. It’s a pretty
laborious process (less so with a small edition) but the sometimes dramatic, sometimes subtle results
can be worth the trouble.

The pattern of the residue will vary depending on the direction of your pull, and how hard you
press, so experiment on blank scrap paper for awhile.
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PRINTING ON T-SHIRTS, CANVAS AND OTHER TEXTILES

To print on any kind of fabric that will be washed in water, use Speedball’s Fabric inks, which can
be chemically heat-set after printing, in order to withstand a washing machine. The directions on the
jar tell you to iron each side of the cloth for 3 - 5 minutes, a tedious prospect if printing more than a
very few shirts. Reliable rumors suggest the alternative of simply putting the dry, printed shirts in a
clothes dryer. Try 30 minutes on the highest heat the fabric can stand, preferably High.

The finer-textured the fabric, the more smoothly it will print. On canvas, for example, the ink is
likely to have a rough look, because the squeegee can reach only the more raised parts of its coarse
weave.

If you wish to screenprint onto canvas that is already stretched on wooden stretchers, you will
need to print with a piece of plywood or board under the canvas that’s the same height as the
stretchers, so that you can apply even pressure with the squeegee. You will also have to use the same
height board in the hinges, under the screen, or have a partner hold the screen in place while you print.
Or rig up some other way of clamping the screen and canvas together.

When we print t-shirts in class, we tape them around a piece of non-corrugated cardboard so the
part to be printed on has no wrinkles. Flatten out the sleeves as much as possible. It might work even
better to also raise both the hinge end of the screen and the image area, using boards thin enough that
the screen still fits into the hinge clamps. Leave a gap between the boards, and there would be more
room for the sleeves and collar. You still should put cardboard inside the shirt to make sure no ink
goes through to the back.

Most fabrics are more absorbent than paper, so textile printing generally takes a coarser screen
mesh and more passes. Typically we use a 195 mesh for printing on fabric, and also have at class one
communal screen with 137 mesh (all these numbers being threads per linear inch). In addition, it
seems to work best to flood the screen and then give at least two passes onto the fabric, unless the
fabric is thin and smooth.

There are several possible ways to mark placement of a t-shirt. Sometimes we use masking tape to
mark on the printing table where to position the shoulders and center line of the shirt. Alternatively,
you can use a large piece of acetate for hinged-flap registration, making sure to have a shirt under the
screen when you first print onto the plastic, since the shirt is bulky enough to affect registration. For
placement decisions, it can be helpful to tape your transparency or master drawing right to a shirt. Try
it on, too, if that helps.

If the shirt won’t fit more or less flat under your hinged screen, detach it and have someone hold it
steady while you print.

Be very careful that there are no leaks in your stencil, or ink on your hands or table that could get
onto a shirt. If ink gets where it shouldn’t, don’t even try to spot-clean it with water. It never works,
even if you do it right away. Wetting it with Simple Green or Awesome Orange is worth a try, if the
unwanted spot is isolated enough from the image. You also could try to incorporate the spot into the
design once it is dry.

Printing onto white or light-colored cloth is best and easiest. It's much harder to get a good white
on a black background. Speedball makes a series of Opaque fabric inks that offer better coverage, but
they are very quick to dry in the screen. If you use them, it may be wise to print a couple of passes onto
a piece of scrap paper just before printing each shirt; certainly do so if it looks like there’s ink lodged in
the screen. Adding a spoonful of retarder thinner should help, so long as the shirts would dry by the
end of class.
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It is difficult to get good enough registration to print additional colors on top of the first, unless
you have a design that doesn’t require much precision. At least, leave your shirt taped to its cardboard
through all the printing steps. Understand that fabric dries much more slowly than paper. A hair dryer
will speed it up, and probably help heat-set it too.

The real way to print lengths of textiles is to have a padded table that the cloth can be pinned
onto, so that it can’t stretch out of shape and out of registration. If you are printing a whole length of
fabric, with repeats, mark where the repeats are. Then, attach a wooden backboard the length of one
long end of the padded table, and move the screen along, clamping it to the backboard with c-clamps
at each marked position. Each time you print, skip the first repeat and go on to the second. Alternating
in this way will help avoid setting the screen down on wet ink.

That's the old-fashioned way. Nowadays, commercial tee-shirt printing shops generally use
carousel printers, where the shirts on their platforms automatically stay in register as they rotate
around a central post, to get to the next screen, with the next color of ink.

PRINTING ON WOOD, GLASS, CLAY, ETC.

You can silkscreen onto practically anything that’s flat enough, though you may have to use
something other than silkscreen ink in some cases, and perhaps invent other adaptations.

Printing on wood works pretty well without much change in technique; most smooth raw wood
absorbs ink about like paper does. If the wood is thicker than 1/4”, you do need to put another board
of the same thickness inside the hinge clamps, under the screen, assuming the clamps can raise that
high. If it’s very thin wood like Masonite, the hinges already lift the screen enough. Make sure you don'’t
get splinters in your screen.

People in my classes have printed successfully on both glass and unglazed ceramics. There is special
glass paint that goes through the screen very readily. Once a piece of glass is printed and dried, a
second sheet of clear glass is fused over top of it.

On clay, a student of mine who is a ceramicist successfully mixed powdered ceramic glaze into
silkscreen transparent base. She printed it onto fairly flat slabs of clay, using a small screen with coarse
mesh. When the pieces were fired, a cobalt blue glaze turned out really great; | don’t recall what other
colors she tried.

More recently, a student had success using colored slip printed through a small coarse screen.
Another found a good way to print onto curved surfaces: She prints with underglaze onto rice paper,
and then transfers it by wrapping the rice paper around the clay piece. The paper burns off in the kiln
and the color adheres to the clay.

Once we silkscreened on the wall, using a regular screen and squeegee, but it was a ridiculously
hard three-person job and I'd never try it again. Yet, | recently ran into another old student, a big tall
guy with the physical strength to make it a one-man job, who has printed some great silkscreened
collages on walls with good commercial success.

On a larger commercial scale, using specialized inks and screens, the unlikeliest objects are
screenprinted: measuring cups, beer bottles, hockey sticks, circuit boards and control panels.
Electrically conductive inks power defrosting systems screenprinted onto the rear windows of cars.
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HOME SET-UP

Ideally, you should have a work table large enough to accommodate your screenprinting frame
side by side with the largest paper you plan to use. The surface you print on needs to be smooth and
flat. 5/8 or 3/4” plywood or a hollow-core door can make a good table. Adhere some type of Formica
to it for a smooth surface; matte is better than glossy, since you don’t want the printing paper to slide
around. If the wood itself is very smooth, just seal it with some coats of (non-glossy) polyurethane, and
print right on the wood. If space limitations dictate it, or your work table is multi-use and not suitable
for permanent hinges, use a portable plywood board, just a little larger than your screen. To hinge the
frame, | recommend a backboard: a 1 x 2” or 1 x 3” piece of sturdy wood a little longer than the frame,
hinged in back to the work table using a continuous hinge (piano hinge) from a hardware or lumber
store. The frame is clamped to the backboard using Vise-Grip clamps (easiest) or C-clamps. If you
prefer, use screenprinting hinge clamps like we have in class. These raise the screen from the table a bit,
intentionally, for “off-contact” printing, which some printers favor but is hard to achieve without a
vacuum table. (See page 53.)

Clean-up You also need someplace to spray-clean the screen, such as a shower base, laundry sink or
bathtub rigged up with a garden or appliance hose attached to the spigot or shower supply pipe. Some
spigots need an adapter or hose clamp, or are too big and decorative to be used at all. Use a heavy-
duty garden hose nozzle. There must be a hot-water line, unless you have a power washer, some of
which should only be used with cold or warm water. (A suitable pressure washer, 1200-1600 psi, runs
somewhere around $150 at Home Depot, Lowe’s, or on-line). | worked for many years without a
pressure washer, since the red Screen Filler is always removable with a garden hose nozzle and hot
water, once you soak it in LA’s Totally Awesome cleaner/degreaser, or other stencil remover. The
removal of Diazo photo emulsion can be more of a problem: It often seems to require a pressure
washer to completely remove the residue. You are welcome to come in on a Monday that our class is
in session and use the pressure washer here. Soaking the screen an hour or so in emulsion remover may
also solve the problem; use a sheet of plastic to keep screen from drying out while soaking. It’s easier if
you don’t leave the emulsion on the screen too long, but even years later it may be removable.

At some point, whether at home or class, stubborn bits of residue (most often photo emulsion)
and/or stains from ink or Screen Filler, render a screen difficult to use. Victory Factory will restretch an
aluminum frame, but the cost of shipping has risen so much that it no longer seems a practical
solution. So | tried a few variations of bleach-washing, and found one that actually does a terrific job.

| am reluctant to allow using bleach in the classroom, but at home you can get away from the
smell of the bleach while it soaks. You should expect to splatter some on your clothes, and your face if
you're not careful. Still, I'm finding that this technique does a remarkably good job of reclaiming screen
fabric to something like its original condition.

1.) Prep: Wear gloves! Protect surfaces.

2.) Set screen on wooden blocks, or layers of newspaper.

3.) Spray with (or wipe on) full-strength Simple Green, to just wet the fabric.

4.) Wipe on full-strength bleach, with a cleaning rag or paper towel.

5.) Turn screen over and wipe bleach onto that side too, so screen is all wet but not dripping.

6.) Use a sheet of plastic, (like a big flat plastic bag) to keep the fabric from drying out.

7.) Soak in a horizontal position for 50-60 minutes.

8.) Spray out with power washer and hot water. If power washer forbids hot water, use warm water.

64 click to go to table of contents NANCY MCINTYRE



Racks To printin any quantity, you probably want some kind of drying racks. Metal or wooden
stacking racks take up quite a bit of room; an alternative is to build clothespin racks like we use in class,
that can be raised on a rope to the ceiling, to take no room at all. Suspend a 1x6 or 1x8” board
horizontally (in just the position you would lay it on the floor), with rows of wooden clothespins
screwed into the long edges of the board at about 3” intervals. Use sheetrock screws, skinny enough to
fit through the coiled wire part of the clothespins so the pins can swing freely. With a rope at each end,
the racks are hung from a hook and a pulley in the ceiling—make sure you find wood above the ceiling
to screw them into. If you have high ceilings or don’t need to raise the racks out of the way, you can
hang two racks, one above the other. The prints dry vertically, held by two clothespins each. To
minimize curling, clip two prints together, back-to-back.

A former student who makes large-scale prints came up with a clever, easy kind of rack: He set up a
big wooden closet pole and hangs his prints on metal clip-type pants hangers.

For photo exposures, find a dark place to let the liquid emulsion dry on the screen: a windowless
bathroom or closet or even a big cardboard box—though it will dry faster if you can
run a fan. With a fan blowing on it and an exhaust fan as well, it should be dry enough in 45 minutes;
with no fan it might take some hours. So long as it stays entirely dark, you can actually expose the
emulsion a day or two later if you wish.

There is no need for darkness where you have the exposure lights. We use 500-watt halogen work
lights. You can buy them individually, for under $20, and build them a bracket, like the 3-light set-up in
class. Home Depot also sells a pair of lights on a stand (around $40) which | use at home. The standard
recommended height is the diagonal measurement of your screen, but that's if you are using only one
bulb.

You can follow the instructions in the Speedball Diazo emulsion kit, and expose the screen with
the printing side up, if you have a flat enough surface that the screen fabric is all in contact with it,
once you put the glass on.

Place black paper directly under the screen to minimize glare, then set down the screen, then your
transparency. Cover with a piece of quarter-inch plate glass of a size that fits comfortably inside the
frame. Even when exposing flat-side up, contact would not be firm if the glass rested on the frame; it
should be entirely on the fabric, if possible. You can use thinner glass but the contact may be less tight
and the thin glass will probably eventually crack from the heat. (If you have a glass place cut the plate
glass, ask them to round the corners a bit.)

The first time you expose with any new set-up, make a test strip to determine the appropriate time
of exposure. For two 500-watt bulbs at a two- to three-foot distance, | would expose it all for 4
minutes, then cover 1/4 of the image with cardboard for the next 4 minutes, half the image for another
4 minutes, and 3/4 of the image for four final minutes.

Please refer to the “Silkscreen Supplies: Where to Buy” chart on next page for where to find screens,
squeegees, and other supplies. There are, of course, more on-line sources than | could mention.

If you've taken my class, don’t hesitate to call for advice. Or, anybody, feel free to e-mail.
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SILKSCREEN SUPPLIES: WHERE TO BUY — 2019
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= available

Halogen work lights: Home Depot or Lowe's; about $15 for one; $40 for two with a stand

Con-Tact paper, Simple Green, paint scrapers: Home Depot and elsewhere

Freezer paper: some supermarkets

LA's Totally Awesome Degreaser & Cleaner: Dollar Tree or Family Dollar

* IMPORTANT NOTE: When buying Speedball inks, avoid the “Water Soluble” series, including “Transparent Extender Base,”
which will all clog a fine-mesh screen, especially if intermixed with Permanent Acrylic or Fabric inks.
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HOW MUCH INK AND STENCIL MATERIALS WILL YOU NEED?

Each printer’s needs are different, but | can give you some guidelines. At home | buy my inks in 8-
ounce size and my Transparent Base and Extender Base by the gallon, because | print with such
transparent colors. | buy 2 or 3 quarts of Screen Filler for every quart of photo emulsion, since | use
primarily block-out stencils.

If you are just starting out, try a good selection of colored inks in 8 oz size, perhaps a quart of white
(and of black if you use a lot of black), and quarts of Transparent and Extender Base. You can get a “kit”
of photo emulsion that includes enough for two small batches of emulsion, plus remover. Start with 8
oz of Screen Filler, and 8 oz of Drawing Fluid because it’s the smallest size they make.

In the long run, for every quart of photo emulsion, get a quart of emulsion remover. (Some
suppliers don’t stock quarts but can get it for you.) For every 2 quarts of Screen Filler, get 8 oz Drawing
Fluid.

During a 9-week, 3 hour, 10-student class, using 23 x 31" screens, we typically use up the following
supplies:

1 gallon each: Transparent Base and Extender Base, mixed together

2-3 quarts: white and black ink

1-2 quarts: Medium Yellow and the 3 Process colors (Yellow, Cyan & Magenta)

¥%— 1 quart: Dark Red, Medium Red, Ultra Blue, Peacock Blue, Dark Blue, Silver, Gold
¥ quart: Orange, Green, Brown, Violet

2-3 quarts: Emulsion Remover

2 quarts: Photo Emulsion and Sensitizer

1 quart Screen Filler

% of an 8 oz container of Drawing Fluid

small amounts of Fabric inks
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ERGONOMICS AND ADAPTATIONS FOR ARTHRITIS

Screenprinting is very physical, and to my mind it's good exercise, overall, as art processes go. But
too much of any repetitive motion can make trouble. There’s a spot near my right shoulder blade that
has bothered me for decades when | do a lot of printing, especially on a large-scale print. It seems to
help when | remember to really pull my shoulders back as | carry my prints to the racks, to counteract
the shoulder-forward posture of pulling the print.

If the height of your table bothers your back or anything else, change it. (Sorry we don’t have that
flexibility in class.) In class, you can at least switch to a stool if the chair seems too low.

Since developing arthritis in my wrists and thumbs a few years back, | have had to set aside my
largest screens, and print on a smaller scale—or not print at all, sometimes. Happily they have not
bothered me much lately, but the discomfort did lead me to the discovery of some helpful adaptations.

For example, | always figured it was the squeegee stroke that put the most strain on hand joints, but
it turns out that, for me, the grasping motion of lifting the screen by the edges of the frame is much
more injurious. A rolling-leg screen support is some help, but the clamp-on type (necessary for
aluminum frames) can be very heavy itself, adding to the weight you have to lift. What really helps is a
HANDLE. | have padded a 2-inch, deep-throated c-clamp and | clamp it onto the frame wherever | can
get the best leverage, and lift the screen by that. The last time | used my large screens, | actually screwed
on drawer handles, but that does preclude reversing the screen so you can work from either end.
Another option one could explore is a counterweight system to automatically raise the screen.

Another thing that can be painful now is my long-time practice of altering my stencils by rubbing
on both sides of the screen with rubbing alcohol on Kleenex. Alcohol is easy to control because it’s
slow-acting, and | didn’t mind having to use more elbow grease, but now | use either acetone or
Awesome Orange, because these days, quick and gentle is best. The Awesome Orange (or emulsion
remover, for a photo stencil) can be diluted to whatever strength strikes the best balance.

When you print, make sure inks aren’t overly stiff. For each color, use as much pressure as necessary
but not more. Unless you need a sharp squeegee for crisp edges or fine detail, try one pass with a dull
squeegee, rather than a flood-coat or two passes with a sharp one.

You can often leave some ink at the hinge end of the screen and some at the near end, so you will
only occasionally need to perform the rather awkward motion of picking up the ink with the squeegee
to carry it across the image back to the reservoir at the hinge end. Try to only carry on the squeegee a
little more than what you need for one pass.

| have been experimenting with resting the squeegee at the hinge end of the screen instead of the
raised end, especially if it's a large squeegee. This gives me less weight to lift each time | raise the screen,
balanced against the motion of reaching all the way to the hinged end when | might be printing only a
small area near the raised end. Another option is to lay the squeegee down directly on the screen, past
(above) the ink reservoir, blade toward you, if there’s room. Many screen printers these days run their
flood coat from front to back and then print from back to front, which cuts down on motion.

Another helpful move, when | am printing a large area, is to stand with one foot ahead of the other.
To begin the stroke, | lean forward, against the screen, raising the heel of my back foot. Rather than
bending my arms much, | rock back smoothly as | pull the squeegee toward me, moving my weight to
the back foot.

Ergonomic squeegees are discussed in the “Squeegees” section. | haven’t found anything that works
better than the classic curved wooden handles, but feel free to look. Avoid rectangular, square-edged
handles, and notice which are more comfortable in your hand, 4” or 5” handles .

Some of these practices might have helped me avoid the arthritis in the first place.
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If you don’t have room to set up at home, and want more time flexibility than my Monday 4-7:00 open
studio times, there are a couple of local options that I'm aware of:

Pyramid Atlantic, now in Hyattsville, welcomes screen printers to use their facilities. Pyramid does
require that you get certified first, by attending a workshop or one-on-one training. Check their
website for details.

Lee Art Center, in Arlington, is worth considering applying to if you are willing to commit to
working there a minimum of four times per month.

In the past | have recommended Carolyn Hartman’s open studio dc. Sadly, they lost their lease;
they might eventually reopen.

My all-time favorite silkscreen book, for those who already have learned the basics of screen printing, is
Water-based Inks: A Manual for the Studio and Classroom, published in 1987 by Lois Johnson and
Hester Stinnett at the Philadelphia College of Art. Their advice was of much help to me when [ first
attempted the switch to the water-based method (and nearly quit in frustration). It’s the only
silkscreen book | ever read that | don’t have a single disagreement with, and every time | reread it, | find
some piece of advice that | hadn'’t picked up on before. Unfortunately, it is out of print. BUT, | recently
discovered t Hester Stinnett, teaching now at Tyler School of Art, allows the whole 40 pages to be
downloaded from her website, www.hesterstinnet.com. (It prints out a little blurry, but legible.)

All still available, the books listed below include instructions for beginners as well as advanced printers:

Screen Printing Today: The Basics, 2" edition
by Andy MacDougall
Media Group International, 2008
Instructions are well-illustrated and good-humored.
MacDougall also runs a well-reputed website and blog, www.squeegeeville.com

Water-Based Screenprinting Today, 2006, and Screenprinting: Water-Based Techniques, 1994
by Roni Hemming, director of the Screenprint Workshop, New York Institute of Technology
Watson-Guptill Publications, 2006

Screenprinting: Contemporary Methods and Materials

by Frances and Norman Lassiter

Hunt Manufacturing Co., 1978
In 1998, after parting ways with Hunt, Speedball republished the book, but didn’t
noticeably update it. The photo-stencil section talks about repro-graphic cameras and other tools
of the 70s, with no mention of computers. And most of the inks used are oil-based, which
Speedball hasn’t sold for decades, far as | know. I've been nagging them for an update.

Print Liberation: The Screen Printing Primer
By Nick Paparone and Jamie Dillon, with Luren Jenison
www.fwpublications.com, 2008
With a refreshing “prints for the people” DIY attitude, the book’s focus is on posters and T-shirts.
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